ADA-PROWAG
District 1 Training

2019

Presenters:
Carlos Feliciano
Amruta Mate
Fawad Aqueel
Ahmad Nafakh
Radoslaw Rostkowski
IDOT ADA/PROWAG District Training

Agenda

Date: December 5th and 6th

Location: IDOT – Schaumburg Office Classroom Auditorium
201 W. Center Court, Schaumburg, IL 60196

Instructors: A. Mate / C. Feliciano/ F. Aqueel/ R. Rostkowski/ A. Nafakh

<table>
<thead>
<tr>
<th>MORNING SESSION: 9:00 – 11:45 AM</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Topic</strong></td>
</tr>
<tr>
<td>9:00    Introductions &amp; Background</td>
</tr>
<tr>
<td>9:15    Requirements</td>
</tr>
<tr>
<td>9:30    D1 ADA Inventory Maintenance</td>
</tr>
<tr>
<td>10:00   <strong>BREAK</strong></td>
</tr>
<tr>
<td>10:15   Pedestrian Access Routes (Sidewalks/Paths)</td>
</tr>
<tr>
<td>10:45   Construction/Alternate Pedestrian Access</td>
</tr>
<tr>
<td>11:00   Sidewalk Ramps</td>
</tr>
<tr>
<td>11:15   Curb Ramps</td>
</tr>
<tr>
<td>11:30   Types</td>
</tr>
<tr>
<td>*Perpendicular</td>
</tr>
<tr>
<td>*Parallel</td>
</tr>
<tr>
<td>*Blended Transitions</td>
</tr>
<tr>
<td>11:35   Detectable Warning Surfaces</td>
</tr>
<tr>
<td>11:45 – 12:45 <strong>LUNCH BREAK</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AFTERNOON SESSION: 12:45 – 4:15 PM</th>
</tr>
</thead>
<tbody>
<tr>
<td>12:45    ADA Design and Labeling Tool</td>
</tr>
<tr>
<td>2:15     ADA/PROWAG Design Memorandum and D1 Project Details</td>
</tr>
<tr>
<td>3:00     <strong>BREAK</strong></td>
</tr>
<tr>
<td>3:15     Pedestrian Street Crossings</td>
</tr>
<tr>
<td>3:30     Accessible Pedestrian Signals (APS)</td>
</tr>
<tr>
<td>3:45     On-Street Parking</td>
</tr>
<tr>
<td>4:00     Miscellaneous – Transit, Utilities, Protruding Objects</td>
</tr>
</tbody>
</table>

PROFESSIONAL DEVELOPMENT HOURS

6.0 PDH - Per Section 1380.325 of the Illinois Administrative Code, 1 PDH shall be equal to a minimum of 50 minutes of instruction or participation. These PDHs do not include any lunch time. This course contributes to the advancement, extension or enhancement of the professional skills in practice of professional engineering and is being developed and presented by persons with education and/or experience in the subject matter.
Illinois Department of Transportation

ADA-PROWAG
District 1 Training

Instructors...

Amruta Mate, P.E.
Project Manager/ADA Coordinator
847 705-4330

Carlos Feliciano, P.E.
In-House Studies Unit Head/ADA & Bikeway Coordinator
847 705-4106

DOT.D1.ADA@Illinois.gov

Fawad Aqueel, P.E.
Plan Preparation Section Chief
847 705-4247

Veselin Velichkov
Design Project Manager
847 705-4433

Introduction...

What we will cover:
- Background
- Requirements
- D1 ADA Inventory Maintenance
- Pedestrian Access Routes (Sidewalks/Paths)
- Alternate Pedestrian Access (Construction)
- Sidewalk Ramps
- Curb Ramps – Types, Detectable Warning Surfaces, Design
- Pedestrian Street Crossings (Crosswalks)
- Accessible Pedestrian Signals (APS)
- On-Street Parking
- Miscellaneous – Transit, Utilities, Protruding Objects, etc.
Background

A Review of the History of ADA/PROWAG

Laws, Guidelines, Standards

Laws Guidelines Standards

Legislature Board Dept. of Justice/Attorney General FHWA/IDOT

STATE
Environmental Barriers Act (EBA) — Illinois
Enacted in 1985 — Amended in 1996


STATE
Illinois Accessibility Code
Updated Effective October 23, 2018

Document Updates
• No longer has a table of contents, index or page numbers
• Now divided into chapters w/ illustrations & tables
• Historical Building section easier to read and interpret
• Gen. Exceptions to construction sites easier to read/interpret
• Updated reader friendly version coming soon

Requirement Updates
• Parking access isles can be shared between spaces
• Exercise Machines/Equipment, Play Areas, Pools accessibility
• New Facility compliance exemption if awarded prior to effective date and built within 12 months (10/23/19)
• Removed many discrepancies with 2010 ADA Standards

Differences between IAC vs. 2010 ADA Standards
• Applies to ALL public facilities and state specific multi-story housing
• Addresses barrier removal only for existing facilities constructed after May 1, 1988 (vs Federal Safe Harbor provision)
• I.E. facility built to 1991 ADA Std or before 3/15/12
• References additional standards relevant to the IAC and provides definitions unique to IAC to align with EBA and incorporates ADAAG
• Requires Statement of Compliance by an architect or engineer for projects with the cost of construction/alteration of $50,000 or more
• PE Seal is our Alternate Statement of Compliance per IL PE Practice Act
• Mandates 20% of units in multi-story housing built after May 1, 1988, must be adaptable

Authority to make determinations delegated to State by 2010 ADA Standards

Includes state-specific requirements regarding alterations that may threaten a historically significant building or facility

Requires accessible parking space signs to display the dollar amount of the state or local fine and be mounted following the state requirements

In most cases, one must have a qualifying disability in order to file an ADA complaint/lawsuit. Without it, one cannot argue their civil rights were violated; however in Illinois, because the IAC is a building code, anyone can file an accessibility complaint.

However, BDE’s position is that the requirements in IAC do not significantly apply to Public Roadways since the focus of the IAC is building and site development which can include transportation facilities within those sites and lead to the Public Right-of-Way.

E.G. Chapter 5 addresses parking requirements but this appears to be limited only to Buildings and Sites, not on-street parking: as such, you can follow IAC for guidance but are not required to do so if altering on-street parking.
Background

**STATE**
Illinois Accessibility Code
Updated Effective October 23, 2018

Finding this Online
(A few kinks to note)

- IDOT Website  
  www.idot.illinois.gov
- Capital Development Board Website  
  https://www2.illinois.gov/cdb/business/codes/Pages/default.aspx

Background

**FEDERAL**
Section 502 of the Rehabilitation Act of 1973

- U.S. Access Board
  25 Total Members
  Meet every other month

- Public Members
  Appointed by President
  4-year terms

- Federal Members
  Represent various federal agencies

Background

**Americans with Disabilities Act (ADA) of 1990 & 2008 Amendment**

- Signed into law by President Bush Sr. on July 26, 1990
  
  1st comprehensive civil rights law protecting people w/ disabilities

- No qualified person with a disability should be excluded from a program, service, or activity because of that disability

- Access Board established ADA Guidelines in 1991 & 2004

- DOJ adopted 2010 ADA Standards based on 2004 Guidelines

- Standards are enforced by the DOJ and DOT (FHWA)

- Required to follow standards as of March 15, 2012
Background

Americans with Disabilities Act of 1990
ADA
Title I: Employment
Title II: Public Programs & Services
Title III: Public Accommodations
Title IV: Telecommunications
Title V: Miscellaneous and Exclusions

Title II applies to all state and local governments regardless of funds received

Background

Pedestrian Facilities in the Public Right-of-way Accessibility Guidelines (PROWAG)

• Published in Federal Register July 26, 2011
• Supplemented on Feb. 13, 2013 to address shared use paths
• DOJ and DOT must adopt standards before it can be enforced (~18 month time frame)
• On January 23, 2006, the FHWA issued a memorandum recognizing that PROWAG standards “are the currently recommended best practices, and can be considered the state of the practice that could be followed for areas not fully addressed by the present ADAAG standards.”

http://www.access-board.gov/guidelines-and-standards/streets-sidewalks/

Background

BLR&S Chapter 8 Transition Plan
Updated October 2013

LPAs must have an ADA Coordinator
Public Notice
Grievance Procedure
Design Standards/Specs/Details
Self Evaluation
Schedule & Budget for Improvements
Monitor & Update
Background

BLR&S Chapter 41 Special Design Elements
Updated October 2013

Incorporates:
PROWAG
ADA Standards for Accessible Designs (ADAAG)
Illinois Accessibility Code (IAC)
Uniform Federal Accessibility Standards (UFAS)
ILMUTCD
American National Standards Institute (ANSI)

Background

BDE Chapter 58 Special Design Elements
Updated January 2018

Section 504
Illinois Environmental Barriers Act
2010 ADAAG
Illinois Accessibility Code
Draft PROWAG

Background

So, what standards do we follow?
Hierarchy

LAWS
1991/2008 ADA
Environmental Barriers Act (Illinois)
Section 504 Rehabilitation Act

GUIDELINES
2010 ADAAG
2013 Draft PROWAG
Illinois Accessibility Code
MUTCD
BLRS/BDE Manuals

11/18/2019
The ADA – PROWAG Requirements

The Transition Plan

IDOT’s Transition Plan

IDOT’s ADA Coordinators

Local Public Agency Transition Plans

Urban Legends of ADA

PROWAG/IAC/BDE/LR&S

The Transition Plan

- ADA required all agencies with 50 or more employees to create one
- Plan had to identify barriers & propose a plan for their elimination
- Agencies had one year to perform self-evaluation then develop a plan within the next 6 months
- All barriers had to be eliminated by Jan. 26, 1995

ADA required all agencies with 50 or more employees to create one

The Transition Plan had to identify barriers & propose a plan for their elimination

Agencies had one year to perform self-evaluation then develop a plan within the next 6 months

All barriers had to be eliminated by Jan. 26, 1995
IDOT’s Transition Plan

- Adopted First ADA Transition Plan: 1992
- Initiated Update to ADA Transition Plan: 2013
- Began Self Evaluation & Inventory: 2013

IDOT is collecting compliance data on: sidewalks, crosswalks, ramps, signals, weigh stations, rest areas

IDOT’s Transition Plan

- Draft Transition Plan Published/Outreach: July 2014
- Inventory Completed: April 2015
- Transition Plan Finalized & Published: Mid 2015

IDOT’s ADA Coordinators

- Mike Brand, P.E., Interim ADA Policy Engineer
- D1 – Amruta Mate/Carlos Feliciano, P.E.
- D2 – Mike Kuehn
- D3 – Scott Ferguson
- D4 – Shana Kane
- D5 – Scott Neihart
- D6 – Sal Madonia
- D7 – Neil Sandschafer
- D8 – Alvin Nieves-Rosario
- D9 – Carrie Nelsen
- Local Roads – Tim Peters
**The Requirements...**

**Local Public Agency (LPA) Transition Plans**

Bureau of Local Roads and Streets  
Circular Letter 2014-18  
ADA Self Evaluation & Transition Plan  
Oct. 2, 2014

“If an acceptable transition plan is not in place, federal and state project authorizations may be withheld on future projects utilizing federal or state funding.”

---

**The Requirements...**

**Urban Legends of ADA**

We don’t have to meet ADA because there is no federal funding — **FALSE!**

All state and local agencies must meet ADA requirements regardless of funding

Not all pedestrian routes must be made accessible — **FALSE!**

If someone without a disability can use the pedestrian facility, it must be accessible to all

---

**The Requirements...**

**Urban Legends of ADA**

If we can't make a route accessible, we can just remove the facilities — **FALSE!**

Removing pedestrian facilities is not an appropriate solution to addressing non-compliance

An unmarked crosswalk is not a legally defined crosswalk. — **FALSE!**

The Illinois Vehicle Code defines a crosswalk as the part of a roadway at an intersection within the connections of the lateral lines of the sidewalks (625 ILCS 5/1-113)
The Requirements...

**PROWAG Scoping Requirements – R2**

- New facilities located in the public ROW – **must meet**
- Altered portions of existing facilities located in the public ROW – meet to max extent practicable within scope – Document!!!
- Temporary and Permanent Facilities in the public ROW are **not required where none exist**, however...

---

**The Requirements...**

- **Existing facilities** that have not been altered, shall not deny access to persons with disabilities.

---

**The Requirements...**

**FHWA Guidance - Alterations**

Links to webinar:

**FHWA Technical Assistance on the ADA Requirements to Provide Curb Ramps through Resurfacing**

[https://connectdot.connectsolutions.com/p2j0u6bt16/?launcher=false&fcsContent=true&pbMode=normal](https://connectdot.connectsolutions.com/p2j0u6bt16/?launcher=false&fcsContent=true&pbMode=normal)

[https://connectdot.connectsolutions.com/p7r08bvr75l/?launcher=false&fcsContent=true&pbMode=normal](https://connectdot.connectsolutions.com/p7r08bvr75l/?launcher=false&fcsContent=true&pbMode=normal)
The Requirements...

Basic Guidance:

Ask, does this project impact the PAR?

If yes, need to bring any facility touching the impacted PAR into compliance

If no, do not need to address the facility; however, check to see where it is on priority list and address if feasible

Pavement Treatment Types

<table>
<thead>
<tr>
<th>MAINTENANCE</th>
<th>ALTERATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chip Seals</td>
<td>New Asphalt Layer</td>
</tr>
<tr>
<td>Fog Seals</td>
<td>New Mill &amp; Fill / Mill &amp; Overlay</td>
</tr>
<tr>
<td>Scrub Sealing</td>
<td>New Cape Seals</td>
</tr>
<tr>
<td>Crack Filling</td>
<td>Joint Crack Seals</td>
</tr>
<tr>
<td>and Sealing</td>
<td>Slurry Seals</td>
</tr>
<tr>
<td></td>
<td>Diamond Grinding</td>
</tr>
<tr>
<td></td>
<td>Surface Course</td>
</tr>
<tr>
<td></td>
<td>Hot In-Place Recycling</td>
</tr>
<tr>
<td></td>
<td>Open-graded</td>
</tr>
<tr>
<td></td>
<td>Microsurfacing / Thin-Lift Overlay</td>
</tr>
<tr>
<td></td>
<td>Rehabilitation &amp; Reconstruction</td>
</tr>
<tr>
<td></td>
<td>Dowel Bar Retrofit</td>
</tr>
<tr>
<td></td>
<td>Pavement Patching</td>
</tr>
<tr>
<td></td>
<td>Surface Sealing</td>
</tr>
</tbody>
</table>

IDOT Project ADA Improvements

3P Resurfacings

- As of FY2015 all resurfacings must bring into compliance to the maximum extent practicable ALL CURB RAMPS THAT ARE ALTERED & those within improvement limits if possible
- Existing physical constraints include, but are not limited to, terrain, ROW, underground structures, adjacent developed facilities, drainage, or the presence of a notable natural or historic feature.

3R/Reconstruction

- All facilities within the improvement limits SHALL be made to be in compliance with PROWAG
### The Requirements...

**Complete Streets vs. PROWAG**

**Complete Streets - Illinois Highway Code (605 ILCS 5/4-220)**
- Bike/Ped full consideration in planning & development
- Bike/Ped shall be established in conjunction with construction, reconstruction or other change of any State transportation facility within 1 mile of urban area
- Goal – creates bike/ped infrastructure **WHERE THERE IS NONE**

**PROWAG (36 CFR Part 1190)**
- Ensure sidewalks, crossings, signals, and other facilities for pedestrian circulation/use constructed or altered in the public ROW are accessible and usable by peds with disabilities
- Goal – compliance and equal access **WHERE FACILITIES EXIST**.

### The Requirements...

**What happens if requirements are not followed?**

**FEDERAL SIDE:**
Because FHWA implements the standards for transportation facilities, **federal funds can be withheld** if an agency does not follow requirements.

DOJ has launched Project Civic Access to ensure counties, cities, towns, & villages comply with ADA. To date, there have been 210 settlement agreements with 195 localities.

[https://www.ada.gov/civicfac.htm](https://www.ada.gov/civicfac.htm)

### The Requirements...

**What happens if requirements are not followed? (continued)**

**STATE SIDE:**
In Illinois, the Attorney General’s office enforces the law. This office has indicated that a licensed engineer/architect who knowingly signs a design not meeting these requirements **risks disciplinary action**.
The Requirements...

Questions

D1 ADA Inventory Maintenance

D1 ADA Inventory Status

Inventory Status as of 2018

• Crosswalks
  • Total Facilities – 29,884 segments – 40% Compliant
    44% (13,102) accomplished in FY18
• Curb Ramps:
  • Total Facilities – 71,552 ramps – 32% Compliant [3% FY15]
    31.2% (22,073) accomplished FY18*
• Accessible Pedestrian Signals (APS)**
  • Total Facilities – 21,386
    6% (1,334) accomplished FY18
• Sidewalks:
  • Total Facilities – 48,607 segments – n/a
• Weigh Stations (12) & Rest Stops (1) – Mostly Compliant

* As of FY18
** As of 2018
D1 ADA – Addressing Compliance

PROGRAMMING TOWARDS ADA COMPLIANCE

D1 ADA – Addressing Compliance

Total Annual ADA Program
Estimate only—Based on a 25 year schedule

<table>
<thead>
<tr>
<th>Facility Type</th>
<th>Number of Facilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Curb Ramps</td>
<td>1,900 ramps</td>
</tr>
<tr>
<td>Crosswalks</td>
<td>294 intersections</td>
</tr>
<tr>
<td>Pedestrian Signals</td>
<td>57 intersections</td>
</tr>
<tr>
<td>Sidewalks</td>
<td>4.8 million SF (1,458 segments)</td>
</tr>
</tbody>
</table>

Note: the equivalent number used for all non-compliant crosswalks are in the same intersection.
Note: The agency responsible for bringing sidewalks in the State ROW into compliance is Local Agency.

D1 ADA Curb Ramp Retrofit

Projects Currently in Engineering Phase I

<table>
<thead>
<tr>
<th>Project</th>
<th>DA</th>
<th>Letting</th>
<th>FY</th>
<th>Cost</th>
<th>Ramps Improved</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>McHenry</td>
<td>01/22/14</td>
<td>03CY14</td>
<td>2016</td>
<td>$458,127</td>
<td>129</td>
<td>CH-60X36</td>
</tr>
<tr>
<td>Lake</td>
<td>11/08/14</td>
<td>06CY17</td>
<td>2018</td>
<td>$246,086</td>
<td>136</td>
<td>CH-62A69</td>
</tr>
<tr>
<td>Kane</td>
<td>09/21/15</td>
<td>01CY17</td>
<td>2017</td>
<td>$712,080</td>
<td>107</td>
<td>CH-62A71</td>
</tr>
<tr>
<td>Will</td>
<td>11/11/15</td>
<td>06CY17</td>
<td>2018</td>
<td>$846,000</td>
<td>668</td>
<td>CH-62A72</td>
</tr>
<tr>
<td>DuPage</td>
<td>12/19/14</td>
<td>06CY18</td>
<td>2018</td>
<td>$1,200,000</td>
<td>600</td>
<td>CH-62G58</td>
</tr>
<tr>
<td>Totals</td>
<td>$3,454,127</td>
<td>1,511</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

D1 ADA Inventory Maintenance

Updated Process per 2016 D1 ADA Memorandum:

- Step 1 – Project Alert (D1 P00038): Bureaus will be required to submit a project alert whenever there is an improvement that will potentially alter a State roadway:
  - *Programming* *Design* *Local Roads* *Traffic Operations*
- Step 2 – Inspection Sheet (D1 P00031): Bureaus altering facilities will inspect each facility altered & keep in their records:
  - *local Roads* *Traffic Operations* *Construction*
- Step 3 – Inspection Summary (D1 P00039): Bureaus will provide a summary of inspections and compliance to ADA Coordinators. Any non-compliance:
  - *local Roads* *Traffic Operations* *Construction*
- Step 3A – Before letting: ADA Statement of Maximum Extent Practicable (BDE 3101)
  - *local Roads* *Traffic Operations* *Construction*
- Step 3B – Before letting: ADA Construction Concurrence (BDE 5801) & email to DOT DI ADA (aminey) or District ADA Coordinator Review & Approval
  - *Programming* *Design* *Local Roads* *Traffic Operations* *Construction*
- Step 4 – ADA Inventory is updated by the Bureau of Programming noting compliance & report annually to BDE/FHWA.
**D1 ADA Inventory Maintenance**

**Step 1 – Project Alert (D1 PD0038)**
- Informs ADA Coordinators of Planned Improvements
- Just needs ADA/PROWAG Project Alert Form found in SharePoint & Location Map with Limits

**D1 ADA Inventory Maintenance**

**Step 2 – ADA/PROWAG Inspection Sheet (D1 PD0031)**
- For your use only, not required to be turned in
- Can also utilize ADA Field Guide Online & SharePoint Manuals
Step 3

ADA/PROWAG Inspection Summary (D1 PD0039)

to update the ADA Inventory (DOT.D1.ADA@Illinois.gov)

NOTE UPDATE COMING IN 2019 – USE SHAREPOINT FORM

Step 3 – ADA/PROWAG Inspection Summary (D1 PD0039)

Submit ADA Statement of Maximum Extent Practicable
To D1 ADA Coordinator (DOT.D1.ADA@Illinois.gov)
(2 weeks prior to monthly FHWA Coordination Meeting)

Must include:
- plan and profile sheets,
- elevations, photos, any other relevant documentation along with design alternatives considered

BDE 31-8.04 (c) & Presents to BDE/FHWA for approval at a Coordination Meeting

BBS – MEP on Local Roads are approved by Local Agency via letter to BDO stating they acknowledge list of solutions to be built in the MEP and added to their Inventory
D1 ADA Inventory Maintenance

Step 3B – Construction Non-Compliance

BDE Form S801
Submit to D1 ADA Coordinator
(DOT.D1.ADA@illinois.gov)

Must include:
plan and profile sheets,
elevations, photos, any other relevant documentation along with
design alternatives considered
for District Approval

BLRS – Construction Concurrency on Local Roads are approved by Local Agency via letter to IDOT stating list of locations to be built non-compliant and added to their Inventory.

D1 ADA Inventory Maintenance

Step 4 – Inventory Update

Available online for INTERNAL use using your desktop or tablet/mobile thru ArcGIS Collector App.

The Requirements . . .

Questions
Overgrown grass that cannot be maintained can create a non-compliant PAR.

Misplaced pole foundations can create a non-compliant PAR.

The clear width of PARs shall be 4’ min., exclusive of width of the curb, but...

Continuous Width – R302.3

Pedestrian Access Routes (sidewalks/shared-use paths)

Pedestrian Access Routes – R302

The Technical Requirements...
Keep in mind landscaping can grow to block the PAR

Parking placement can impact the PAR


www.pedbikeimages.org / Justin Pryzby

www.pedbikeimages.org / Dan Burden

www.pedbikeimages.org / Maury Steindel
The Technical Requirements . . .

Clear width ≥ 5’

The clear width of PARs within medians and pedestrian refuge islands shall be 5’ min.

Continuous Width – R302.3

The Technical Requirements . . .

A PAR shall be provided for the full width of a shared use path

Shared use path

Continuous Width – R302.3.2

The Technical Requirements . . .

Where PAR clear width is 4’, provide a 5’ x 5’ passing space every 200’

Figure R302.4 Passing Spaces

Passing Space – R302.4
What is a Suitable Grade?

5% MAX.
or
≤ Road Grade

Grade – R302.5

Cross slope must be ≤ 2%

Cross Slope – R302.6

PAR
Best practice is to carry the sidewalk through the driveway.
The Technical Requirements...

Driveways

Cross Slope – R302.6

The Technical Requirements...

Driveway Cross Slope

Cross Slope – R302.6

The Technical Requirements...

Is a construction tolerance allowed?
- Nope

IDOT is currently designing for:
- 1.5% cross slopes
- 1:14 (7.14%) running slopes

Keep this in mind when designating slopes/measurements on plans
### The Technical Requirements...

<table>
<thead>
<tr>
<th>Firm</th>
<th>Stable</th>
<th>Slip resistant</th>
</tr>
</thead>
</table>

**Surfaces – R302.7**

#### Examples of surfaces that might not be ideal

**Surfaces – R302.7**

#### Vertical Discontinuities

**Surfaces – R302.7**
The Technical Requirements ...

**Vertical Discontinuities**

*Trip Hazards*  
> ¼”

Surfaces – R302.7

---

The Technical Requirements ...

**Horizontal Openings**

Long dimension perpendicular to dominant direction of travel  
½” max

Surfaces – R302.7

---

The Technical Requirements ...

**Horizontal Openings**

Surfaces – R302.7
The Technical Requirements...

Horizontal Openings

Spacing ½" max

Surfaces – R302.7

The Technical Requirements...

Flangeway Gaps at Pedestrian Rail Crossings

Railroad Flangeway Gaps

Non-freight

Freight

Surfaces – R302.7

The Technical Requirements...

Flangeway Gaps at Pedestrian Rail Crossings

Surfaces – R302.7
The Technical Requirements...

Construction/Alternate Pedestrian Access Routes

**BDE 58-1.01(c) – Maintaining Accessibility in Construction**
- **MUST** be maintained consistent with the features in the existing facility.
- Designer may need to provide for reconstruction of certain curb ramps or temporary facilities outside of project limits at different times to maintain accessibility.

**BDE 55-2.01(d) – Pedestrians/Bicyclists**
- Work should be done in a manner that does not disrupt otherwise,
- Follow MUTCD guidance for alternate routes

The Technical Requirements...

**IDOT Work Zone Traffic Control**

**BDE 58-1.01(c) – Maintaining Accessibility in Construction**
- **MUST** be maintained consistent with the features in the existing facility.
- Designer may need to provide for reconstruction of certain curb ramps or temporary facilities outside of project limits at different times to maintain accessibility.

**BDE 55-2.01(d) – Pedestrians/Bicyclists**
- Work should be done in a manner that does not disrupt otherwise,
- Follow MUTCD guidance for alternate routes

The Technical Requirements...

**IDOT Work Zone Traffic Control**

Guidelines:
- **Separation** – physically separate ped/bikes & vehicles where practical
- **Duration** – plan construction to disrupt shortest practical time or during non-peak times
- **Detours** – pedestrian detours **SHOULD BE AVOIDED**, if used, design to minimize adverse travel & crossings
  - Rarely are observed
  - Cost of an accessible detour might outweigh cost of maintaining the existing access route.

Alternate Pedestrian Access Routes – BDE 55 & 58

Alternate Pedestrian Access Routes – R303

Alternate Pedestrian Routes—BDE 55 & 58
### The Technical Requirements . . .

**PROWAG R303 → R205 → Chapter 6 of the MUTCD**

**MUTCD Section 6D.01**
- **SHALL** provide advance notification of sidewalk closure
- **SHALL** provide adequate pedestrian access and walkways through Temporary Traffic Control

**MUTCD Section 6D.02**
- Temporary facilities **SHALL** be detectable and accessible
- Audible information devices **SHOULD** be used

### Alternate Pedestrian Routes – R303

---

### The Technical Requirements . . .

**IDOT Work Zone Traffic Control**

**Temporary Sidewalks** (BDE 55-2.01(d)):
- **Width**
  - Same as existing but minimum 4 ft.
  - Wider should be considered with high pedestrian volume
  - If < 5 ft - provide 5 ft x 5 ft passing space every 200 ft
- **Surface**
  - Firm, stable & slip resistant
  - **If remaining in place > 4 weeks,** provide 2 in. Cement/Asphalt surface *(material at contractor's option)*
  - **If < 4 weeks,** 3 in. compacted aggregate may be used

### Alternate Pedestrian Routes—BDE 55

---

### The Technical Requirements . . .

**Channelizing Devices – Sec. 6F.63 MUTCD**

Devices shall be detectable:
- Continuous detectable bottom/top surfaces
- Bottom shall be no higher than 2 in
- Top shall be no lower than 32 in

*Min 32” Max 2”*
### The Technical Requirements . . .

<table>
<thead>
<tr>
<th><strong>Same-side alternate routes</strong></th>
<th>✓ extra crossings increase risk</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Covers temporary facilities</strong></td>
<td>✓ street fairs, block parties, farmers’ markets</td>
</tr>
<tr>
<td><strong>MUTCD (6D.02)</strong></td>
<td>✓ APS and audible information devices <em>SHOULD</em> be used</td>
</tr>
<tr>
<td></td>
<td>✓ Engineering Judgment <em>SHOULD</em> be used</td>
</tr>
</tbody>
</table>

**Alternate Pedestrian Routes – R303**

<table>
<thead>
<tr>
<th><strong>Not acceptable</strong></th>
</tr>
</thead>
</table>

**Alternate Pedestrian Routes – R303**

<table>
<thead>
<tr>
<th><strong>Acceptable examples</strong></th>
</tr>
</thead>
</table>

**Alternate Pedestrian Routes – R303**
The Technical Requirements . . .

Acceptable examples

Highway Standard 701801 – Sidewalk Closure
Note: only one corner closed off to allow for an alternate pedestrian route to around construction

As of 04CY17 this general note is now included in all resurfacing contracts:

“Contractor shall maintain pedestrian access at all times during construction”

Alternate Pedestrian Routes – R303

The Technical Requirements . . .

Highway Standard 701801 – Sidewalk Closure
Temporary facilities shall be provided & this standard is used in conjunction with other Traffic Control & Protection Standards

Alternate Pedestrian Routes – R303

The Technical Requirements . . .

Highway Standard 701801 – Sidewalk Closure
Note: only one corner closed off to allow for an alternate pedestrian route to around construction

As of 04CY17 this general note is now included in all resurfacing contracts:

“Contractor shall maintain pedestrian access at all times during construction”

Alternate Pedestrian Routes – R303

The Technical Requirements . . .

Highway Standard 701801 – Sidewalk Closure
Temporary facilities shall be provided & this standard is used in conjunction with other Traffic Control & Protection Standards

Alternate Pedestrian Routes – R303
The Technical Requirements . . .

Ramps

- 5% ≤ Running Slope ≤ 8.3%
- Cross Slope ≤ 2%
- Clear Width (w/ or w/o handrails) ≥ 3’ (36”)
- Rise ≤ 2.5 feet (30 inches) max
- Landing slope in any direction 2% max
- Length minimum 5 feet
- Surface shall be firm, stable, & slip resistant

Access Routes vs. Sidewalk Ramps vs. Curb Ramps

Ramps—R407 (BDE 58-1.08)
Ramp Landings

**Strait**
- 5’

**Change in Direction**
- 5’

**3’**

- At least as wide as ramp run

NEW: 1:12 (8.3% max)

REPLACE:
- 3” rise = 10% (1:10) - 12.5% (1:8) max
- 6” rise = 5.3% (1:19) - 20% (1:5) max

*If rise >6” or length >72” (IAC)*

Ramps—R407 (BDE 58-1.08)

Handrails

- Provide handrails on both sides of ramps and stairways (R409.2)
- Shall be continuous within full length of ramp run or stair flight
- 34” ≤ Top of gripping surface ≤ 38” above walking/ramp surface
- Handrails shall extend 12” min. beyond ramp runs

Handrails—R409 (BDE 58-1.08)

The Technical Requirements...

Ramps—R407 (BDE 58-1.08)

The Technical Requirements...

Ramps and Handrails

- Ramp runs with a rise >6 inches (R407/409 & IAC 405.8)
  
  or horizontal projection (i.e., length) >72” (IAC)
  
  long shall have handrails
- Provide edge protection (R407.9.1 & IAC 405.9) on each side of ramp run and ramp landing
  - Extend the ramp run or landing ≥≥ ≥≥ 12 inches beyond inside face of the handrail (R409)
  - If you cannot, then use barrier/curb min. 2” high
- Provide a curb or barrier preventing passage of 4-inch sphere within 4 inches of surface

Handrails—R409 (BDE 58-1.08)
The Technical Requirements . . .

Ramps and Handrails

- Barrier 2” high min (rail/curb)
- OR
- 12” extended platform
- 34” to 38”
- X < 4
- 12 min
- 36” min
- 12 min

Handrails—R409 (BDE 58-1.08)

The Technical Requirements . . .

Handrails

- Clear space between handrail and wall: 1.5”
- Mounted between 34” and 38” above ramp
- Shall not rotate within their fittings

Handrails—R409 (BDE 58-1.08)

The Technical Requirements . . .

Handrails

- HOWEVER!
  Handrails along State Highways are strongly discouraged as they pose a hazard along the roadway
  USE WITH CAUTION & SPARINGLY

- Consider only when:
  - Perpendicular to the direction of roadway travel and outside the clear zone
- Most other cases consider instead:
  - Transition Zones if connecting to existing
  - Acquiring ROW to allow curved PAR at 5% max running slope
  - Using 15-ft Rule

Handrails—R409 (BDE 58-1.08)
The Technical Requirements...

Access Routes vs. Sidewalk Ramps vs. Curb Ramps

The Technical Requirements...

Grade breaks:
- Can’t be located on the ramp run or turning space
- Must be perpendicular to direction of travel

Grade Breaks – R304.5.2

The Technical Requirements...

Perpendicular Grade Break

Grade Breaks – R304.5.2
The Technical Requirements...

Cross slope shall be ≤ 2% at:
- Curb Ramps
- Blended Transition
- Turning Spaces

However, at pedestrian street crossings:

Without yield/stop (i.e. Uncontrolled/Traffic Signals) cross slope shall be ≤ 5%

Mid-block crossing cross slope can be ≤ street grade

The Technical Requirements...

Counter slope of Gutter 5% or Less

Concrete Curb Type B and Combination
Concrete Curb and Gutter
Standard Slope - 0°
**The Technical Requirements . . .**

**Transition from Lower Landing to Crosswalk**
A curb ramp at a cross slope of 2% is allowed to transition to a crosswalk at a cross slope of 5% at a signalized intersection at the lower landing area because you are going from one compliance to the next and the level landing requirements are not required in this case.

![Transition to Crosswalk](image)

**The Technical Requirements . . .**

Provide a min 4' x 4' clear space beyond the grade break. Must be width of crossing and outside the parallel vehicle lane.

![Clear Space – R304.5.5](image)

**The Technical Requirements . . .**

4' x 4' Clear Space
- Detectable Warning
- Must lie within width of x-walk
- Must be wholly outside parallel vehicle path

![Clear Space – R304.5.5](image)
The running slope of the curb ramp shall be 5% minimum and 8.3% maximum but shall not require the ramp length to exceed 15.0 ft.
The Technical Requirements...

Example – NOT "chasing grade"

15 FT Rule

The Technical Requirements...

Chasing Grade & the 15-foot rule

Running Slope / Grade Break – R304.2.2

The Technical Requirements...

Perpendicular Curb Ramp Standard 424004-11

SIDE CURBS NOT REQUIRED / LOWER LANDING vs CLEAR SPACE

IDOT vs PROWAG
The Technical Requirements . . .

Types of Curb Ramps Discussed:
- Perpendicular
- Parallel
- Combined Curb Ramps
- Blended Transitions / Depressed Corners
- Diagonal

Summary of Types

Curb Ramps & Blended Transitions – R304
The Technical Requirements . . .

Perpendicular Curb Ramps

Perpendicular Curb Ramps – R304.2

---

Perpendicular:
running slope (5 to 8.3%) cuts through or is built up to the
curb at right angles or meets the gutter break at right angles
where the curb is curved.

Curb Ramps & Blended Transitions – R304

---

The Technical Requirements . . .

Perpendicular Curb Ramps

Curb Ramps & Blended Transitions – R304

---
The Technical Requirements...

Provide a minimum 4’ x 4’ turning space at top of perpendicular curb ramps @ 2% RS/XS

The Technical Requirements...

If constrained (by curbs/bldgs) provide minimum 4’ by 5’ in direction of ramp run

The Technical Requirements...

Perpendicular Ramps

5% ≤ Running slope ≤ 8.3%
The Technical Requirements . . .

Blended Transition

Running slope ≤ 5%

5.0% max

Running Slope / Grade Break – R304.2.2

The Technical Requirements . . .

Incorrect placement of the grade break causes the wheel guiding the chair to leave the pavement

Not a right angle

Running Slope / Grade Break – R304.2.2

The Technical Requirements . . .

Design question becomes – where do you place the transitions and grade breaks and still be compliant?

Running Slope / Grade Break – R304.2.2
Parallel:
running slope that is in-line with the direction of sidewalk travel and lower the sidewalk to a level turning space where a turn is made to enter the pedestrian street crossing.
The Technical Requirements . . .

**Provide a min. 4’ x 4’ space at bottom of curb ramp**

- Direction of crossing: 4’
- 4’ in direction of crossing or 5’ if constrained

**Turning Space – R304.3.1**

The Technical Requirements . . .

**Running slope of ramp shall be in line with direction of sidewalk travel and be 5% min and 8.3% max**

- 5% ≤ Running Slope ≤ 8.3%
- 2% max Cross Slope & running slope of turning space

**Running Slope – R304.3.2**

The Technical Requirements . . .

**Combined Perpendicular/Parallel:**

A parallel curb ramp is used to lower the sidewalk to a mid-landing and a short perpendicular curb ramp connects the landing to the street.

**Curb Ramps & Blended Transitions – R304**
The Technical Requirements . . .

Blended Transitions:
A raised pedestrian street crossing, depressed corner, or similar connection that has a grade ≤ 5%
The Technical Requirements . . .

Running slope of blended transitions shall be 5% max

For shared use paths, width of blended transitions must be = width of shared use path

Running Slope – R304.5.1

The Technical Requirements . . .

DEPRESSED CORNER RAMP IDOT STD 424021

Running Slope – R304.5.1

The Technical Requirements . . .

If exceeding IDOT's 2% running slope then provide a turning PAR for pedestrians not crossing road

4' width at 2% cross slope

Running Slope – R304.4.1
Diagonal Curb Ramp – Legacy Type

Can only use if all other types are technically impractical
Primarily used on alteration projects

Curb Ramps & Blended Transitions – R304

Questions
The Technical Requirements...

**Detectable Warning Surfaces**

Detectable Warning Surfaces – R305

The Technical Requirements...

**Dome Size – R305.1.1**

The Technical Requirements...

**Dome Spacing – R305.1.2**
The Technical Requirements . . .

Detectable Warning Surfaces

Dome Failures

Dome Spacing – R305.1.2

Detectable Warning Surfaces

Must provide color contrast:
Light on dark or dark on light
Green DWS on concrete ARE NOT acceptable

Contrast – R305.1.3

Detectable Warning Surfaces

Example of method of providing good color contrast within a brick field

Contrast – R305.1.3
The Technical Requirements . . .

Detectable Warning Surfaces

- Extend 2’ min on ramp
- Full width
- At the Back of Curb
- Concrete border 2”
- Properly oriented to grade break

Size – R305.2

The Technical Requirements . . .

In median, at edge of island with 2’ min. separation from other DWs

Placement (Pedestrian Refuge Islands) – R305.2.4

The Technical Requirements . . .

At rail crossings, min. 6’ – max. 15’ from nearest rail and behind pedestrian gates

Placement (Pedestrian At-Grade Rail Crossings) – R305.2.5
Detectable Warnings at Driveways & Alleys

BDE 58-1.09 (c) 2. Location. “... Detectable warnings are also required where sidewalks cross alleys and commercial entrances where traffic control devices (e.g., yield signs, stop signs, or signals) are present.”

SO......

Placement – R305.2

Detectable Warnings at Driveways & Alleys

Place only if devices are warranted through a traffic study. HOWEVER Guidance has been given to use discretion when following this:

• Too many DWs along a route can confuse those who are visually impaired.
• Some driveways with a large amount of traffic should have detectable warnings regardless of traffic control devices.

Placement – R305.2

INCORRECT PLACEMENT – Not full width

Placement – R305.2
The Technical Requirements...

2018 UPDATE

INcorrect PLACEMENT

Exceeding BOC tolerance

Placement – R305.2

The Technical Requirements...

Grade break behind BOC and ≥ 5' from BOC:
Place on ramp run within one dome spacing from grade break.

Grade break in front of the back of curb (BOC):
One or both ends of the bottom grade break are more than 5' from back of curb.

Placement (Perpendicular Curb Ramps) – R305.2

The Technical Requirements...

Highway Standard 424001 Update 2017

Placement – R305.2
As of 2018 Construction Season

DETECTABLE WARNINGS (SPECIAL)
- Detectable warning tiles shall be cast iron. The color of the detectable warning tiles is to be approved by the Engineer.
- The cast iron detectable warnings shall be of uniform quality and free of surface defects.
- The detectable warnings shall meet requirements of ASTM A48 Class 30 or better.

SIGNALIZED INTERSECTIONS w/ TIGHT RADII
- 8” PCC on the corner landing (detectable warning section) due to trucks driving over the corners

CHICAGO CONTRACTS SPECIAL PROVISION

Questions
DESIGNING CURB RAMPS FOR ENGINEERING STUDIES

1.14 / 1.16% Desired
1.12 Max
0.33% Max
2.00% Max

PR ELEV = ELEV + 2% * X + L * 8.33%
PR ELEV = ELEV + (-W_gutter * 5% + 0.5") / 12
The Technical Requirements...

1. Determine if the running slope of your currently proposed ramp is under 8.3%. If so, then label the running slope. If not, then you’ll need some re-design of SW.

2. \( L = 6"/7.14\% \) Make an assumption on how high you want your ramp to go up, say 6” (B-6.24 CC&G).

3. \( \text{PRE ELEV}_{\text{TOP RT}} = \text{PRE ELEV}_{\text{BOC}} + X \times 1.5\% \) (Lower landing).

4. \( \text{PRE ELEV}_{\text{TOP RT}} = \text{ELEV}_{\text{EOP}} + \left( \frac{-W_{\text{gutter}} \times 5\% + 0.5"}{12} \right) \)

5. Repeat with other edge.

6. Determine if 6% slope is < 2% (1.5% preferred).

7. If not, then you’ll need some re-design of SW depending on high/low keeping in mind your running slope.

8. \( \text{PRE ELEV}_{\text{TOP LT}} = \text{PRE ELEV}_{\text{TOP RT}} + W \times 1.5\% \) (Typically 5’).

9. Figure out the corners of your turning space @ 4’x4’ unconstrained or 4’x5’ constrained @ 1.5% PRE (chamfer) in all directions.

The Technical Requirements...

CLASS EXAMPLE

The Technical Requirements...

CLASS EXAMPLE
The Technical Requirements...

1. Determine if the RS of your currently prop RAMP is <8.3%. If so then label the RS.

2. If not, then you'll need some redesign of SW in this case, which was undesirable from relocation, signal box, etc. Hence a depressed curb was used. Edge of ramp should be parallel to crosswalk.

3. PR ELEV TOP RAMP = PR ELEV BOT RAMP + 8.33% x L

4. ∆L = 4'

5. Next side walk:

6. Repeat with other edge carrying 1.5% at bottom of ramp: PR ELEV BOT RAMP = PR ELEV BOT RAMP + W x 1.5%
Say it's a 6" rise, the 5% area would have to be 8.4' wide for a total corner distance of 12.4'.

\[ \Delta y_{PAR} = 2\% \times 4' = 0.08' \]
\[ 0.5' - 0.08' = 0.42' \]
\[ \frac{\Delta x}{5\%} = \frac{0.42'}{5\%} = 8.4' \]
Add the 4' @ 2% total width of ramp = 8.4' + 4' = 12.4'

**Parallel Ramps**

\[ \text{PR ELEV}_{\text{TOP RAMP 1}} = \text{PR ELEV}_{\text{BOT RAMP 1}} + 8.33\% \times L \]

**NOTE THAT YOU MAY HAVE DIFFERENT RAMP DESIGNS ON EITHER SIDE DEPENDING ON YOUR SITE NEEDS**

**Ramp Detail Sheets**

- Provide dimensions to ensure alignment and continuity of ramps.
- Provide dimensions to ensure compatibility with existing facilities.
- Include provisions for drainage and accessibility.
- Provide directions for installation and maintenance.

**Geometric Requirements**

- Provide 20 scale plans for sidewalks and ramps.
- Include traffic signal post locations and push button directions.
- Ensure there is enough room for the required elements.

**Provisions**

- Provide dimensions for ramps and curb ramps.
- Include provisions for drainage and accessibility.
- Ensure compatibility with existing facilities.

**Materials**

- Provide materials specifications for ramps and curb ramps.
- Include provisions for drainage and accessibility.
- Ensure compatibility with existing facilities.
The Technical Requirements...

- Use Table with Station and Offsets
- Use Leaders to declutter drawing
- Show widths / slopes

The Technical Requirements...

- Use Reference Points
- Show Elev, Slope & Distances

ADA Design Automation Tool

CURB RAMPS DESIGN WITH CADD
(ADA Automation Tool)
### ADA Design Automation Tool

#### Introduction
- Purpose: presenting a developed method/procedure helps make sidewalk design process a more efficient process
- It’s not to show you how to design, rather once familiar with ADA/BDE/PROWAG design standards and guidelines, it expedites the design process by minimizing error and saving time
- Two main components to the developed method:
  - Replacement of the iterative process (use of a spreadsheet)
  - Semi-dynamic labeling (use in MicroStation)
- Expectations: a 4-6 hours design can be done in 1-2 hours

#### Disclaimer
- ADA Automation Tool – as the name suggest – is just a tool
  - Results are dependent on how it’s used
- It assists in the design process
- The user is responsible for the results

#### Process
- Typical sidewalk detail creation:
  - Geometric layout
  - Sidewalk design
  - Labeling
  - Plan preparation

  } Steps modified by new process
**ADA Design Automation Tool**

**Process: expanded steps**

0. Initial preparation of survey data and CADD files  
1. Geometric layout  
2. Point creation  
3. Point extraction  
4. Sidewalk design  
5. Point import  
6. Labeling slopes elevations dimensions  
7. Sheet preparation  
8. Quantities  
9. Benchmarks  
10. Sheet creation

Steps modified by new process, focus of presentation

**Summary**

- Iterative process is automated (let the computer figure it out)
- Labeling is done based on designed data (minimizing chance for error & reduce time)
- Method is applicable to OpenRoads Designer (future proof)  
  - A 3D model can be easily created
- ADA detail creation can be expected to take 1-2 hours (from survey data to deliverable)  
  - As shown in the A to Z demonstration

**The Technical Requirements . . .**

**ADA Ramp Details on Contract Plans**
Design Guidance # 1

- Please read all of the notes in the ADA templates before beginning design.
  - ADA Quantities should be available in a schedule or called out on plans
  - Due to plan changes, designers don’t always include schedules in the plans. Check with designer during preconstruction meeting.

Design Guidance # 2

- Ensure ADA details are legible on an 11x17 plan sheet.
  - Settings in the template are for IDOT workstations
  - Adjust text size as needed.

Design Guidance # 3

3. Request ground survey:
   - Use either the roadway plan sheet (preferred) or Google Maps image
   - Circle corners that need ADA survey done
   - Checking GIS inventory for ADA contracts completed is mandatory
   - Many contracts resurfaced from 2009-2012 have ADA design being done by PH 1 consultants for standalone ADA contracts.
The Technical Requirements . . .

Design Guidance # 3

- Do not request survey for simple corners where sidewalk is replaced in kind
- These can now be constructed using a District Standard (currently in testing for 2020 for IDOT Bureau of Design contracts only)

The Technical Requirements . . .

Design Guidance # 3

- Clarify if corner islands or medians are to be included
- Look out for utility conflicts such as sprinklers for ADA design

The Technical Requirements . . .

Design Guidance #4 and #5

- Submit ESR for special waste to environmental unit
- Assume the following for 5 foot wide sidewalk
  - 1 Ramp/Corner = 150 SQ FT
  - 2 Ramps/Corner = 200 SQ FT
  - Depressed Corner = 250 SQ FT
- Earth excavation estimated at .01 Cubic Yard/1 SQ FT on flat ground with no subbase
The Technical Requirements . . .

Design Guidance #6

• Remember to look out for bus stops if reconfiguring ADA curb ramp
  – Coordinate with PACE for relocation of shelters

Design Guidance #7 and #8

• Coordinate with municipality for relocation of benches
• Maintain brick sidewalks if existing conditions have bricks
• Bricks must meet ADA/PROWAG requirements

Design Guidance #9 and #10

• Any push button outside of the 30”-42” vertical height requirement will require relocation at 36”
• Pave sidewalk up to push button
• If above not possible install a push button extension
• 2.5’x4’ paved clear space in front of push button
• No new ped signal posts on resurfacing contracts
• Discuss with traffic if you feel pedestrian signals are warranted at a specific location
The Technical Requirements . . .

**Design Guidance #11**

- Rebuild any existing handholes that are impacted
- Add appropriate special provisions
- If raised median being converted to striped median rebuild existing handhole to heavy duty handhole
- Will require signal maintenance transfer

**The Technical Requirements . . .**

**Design Guidance #12**

- Acceptable to have utilities within the curb ramp
- Detectable warning portion must be free of any utilities such as handholes, frames, or lids.

**The Technical Requirements . . .**

**Design Guidance #13**

24” Frames and lids to be adjusted by IDOT contractor
The Technical Requirements . . .

**Design Guidance #13**

- 6” water valve to also be adjusted by IDOT contractor
- Sanitary, gas, or any other utilities are to be adjusted by municipality or utility company
- Plans must call out location of adjustment

---

**Design Guidance #14**

- ADA curb ramps can be removed if there are safety concerns
  - Only remove ramps after coordination with D1 Bureau of Traffic Bike and Pedestrian Engineer and Local Agency
  - Inform D1 ADA coordinator so the ADA inventory can be updated

---

**Design Guidance #15**

- Resurfacing with ADA curb ramps
  - Add construction layout special pay item and spec
- No ADA on resurfacing then no construction layout special pay item required
- All other projects such as channelization with ADA will use regular construction layout pay item
- Don’t use both pay items in a contract
The Technical Requirements . . .

Design Guidance #16

- CDOT requires cast iron detectable warnings
  - Use detectable warning special pay item
- Landings and curb ramps are to use 8” PCC at all signalized intersections within City of Chicago

The Technical Requirements . . .

Design Guidance #17 and #18

- If only ADA design element that is non-compliant is detectable warning then full ADA plan detail will not be provided
- A callout with location of improvement on plan sheet will be provided
- Resurfacing plans should indicate location of all ADA improvements

The Technical Requirements . . .

Design Guidance #19

Follow 15 foot rule
Design Guidance #20

• Design is estimating on SOQ 4 foot wide full depth patches
  • 50% of ADA corners for resurfacing contracts
  • 100% of corners on stand alone ADA contracts

Design Guidance #21

• Ensure water flows off sidewalk
• Note locations of inlets on reconstructions
• Remember pay item lids, type 1, open lids for any lids within the depressed curb portion of curb ramp

Design Guidance #22

• Add General Note
  “The contractor shall maintain pedestrian access at all times during construction”
The Technical Requirements...

Design Guidance #23

- Upper landings are preferred by IDOT highway standards, but not required per PROWAG
- Transition segment is not considered an upper landing therefore no MEP is required

Design Guidance #23 and #24

- No MEP is required if the cross slope of a transition segment is greater than 2%
- No MEP is required for a 2% cross sloped ramp to a 5% cross sloped crosswalk at a traffic signal

Design Guidance #24

- MEPs are not required on transition segments when connecting an altered compliant element to an existing element.
### The Technical Requirements . . .

#### Design Guidance #25, #26 and #27

- MEPs will not be approved for alternative pedestrian routes during construction during the planning and design phase
- Generally MEPs will not be approved for reconstruction projects
- Submit MEPs to DOT.D1.ADA@illinois.gov 2 weeks before FHWA meeting date
- All MEP paperwork must be provided to resident engineer at preconstruction meeting

#### The Technical Requirements . . .

#### Project Details for Curb Ramps

- IDOT D1 has a tiered approach to ADA design
- For simple corners surrounded by grass and that are remove and replace sidewalk with new grades use D1 ADA project details
- Complex designs will require detailed survey and design
- Currently in testing for 2020 – only use on IDOT led contracts (not for local agency contracts)

#### The Technical Requirements . . .

#### Project Details for Curb Ramps

- Cannot use standard template when curb ramp
  - Is surrounded by PCC or Asphalt
  - Has a nearby building that constraints design
  - Is near driveways that will not be modified
  - Has potential utility conflicts or signal poles that make design difficult
  - When private sidewalk is tying into proposed sidewalk
  - Sidewalk is being realigned
  - Brick corners are discouraged
The Technical Requirements . . .

The Technical Requirements . . .

The Technical Requirements . . .
PROWAG does not tell you when or how to mark the crosswalk

Instead refer to MUTCD Section 3 for guidance
Pedestrian Street Crossings:

At non-intersection (i.e. mid-block) locations, *crosswalk markings legally establish the crosswalk.*

—MUTCD Sec 3B.18 (03)

---

Pedestrian Street Crossings:

Per PROWAG R207:
Curb ramps and blended transitions **must** be wholly contained within the pedestrian street crossing

And per MUTCD Sec 3B.18 (17):
Crosswalk markings **should** be located so that the curb ramps are within the extension of the crosswalk markings

---

Example of ramp not contained within crosswalk
Pedestrian Street Crossings:

Traffic Signal/Uncontrolled

Street grade

mid-block crossing cross slope can be ≤ street grade

Stop/Yield Signs

Pedestrian Street Crossings – R306

The Technical Requirements . . .

Pedestrian Street Crossings

Remember running requirements:

≤ 5% running slope for pedestrian access route

≤ 5.00%

Pedestrian Street Crossings—Running Slope

The Technical Requirements . . .

Pedestrian Street Crossings:

Signal Phase timing shall comply with Section 4E.06 of the MUTCD

(Pedestrian walking speed of ≤3.5 fps)

Pedestrian Signal Phase Timing – R306.2
Roundabouts:
Difficult Crossing for Vision Disability
R306.3.2 Pedestrian Activated Signals
Multi-lane pedestrian street crossing requires pedestrian activated signal:
- HAWK (High-Intensity Activated Cross-Walk)
- RRFB (Rectangular Rapid Flashing Beacon)

Roundabouts – R306.3

The Technical Requirements . . .

Typical Median
Edge Treatment Examples

Roundabouts – R306.3

The Technical Requirements . . .

Accessible Pedestrian Signals (APS)
& Pedestrian Pushbuttons

Accessible Pedestrian Signals & Pedestrian
The Technical Requirements . . .

**Push Button Location**

Per MUTCD 4E.08 through 4E.13

**Accessible Pedestrian Signals & Pedestrian Pushbuttons--R307 & R209.1**

---

The Technical Requirements . . .

**Pushbutton Design**

2” Dia. & operable w/ a closed fist
Max 5 lbs pressure to activate

**Accessible Pedestrian Signals & Pedestrian Pushbuttons--R307 & R209.1 & R403**

---

The Technical Requirements . . .

**Pushbutton Design**

- **Clear Space:**
  - min. 2.5’ (30”) x min. 4’ (48”) but if clear space is confined...
- **Height:**
  - MUTCD - 42” preferred (48” max)
  - IDOT Highway Standard 876001-04 - 36” preferred (30” min, 42” max)
- **Maneuvering Space:**
  - For **forward** approach:
    - min. 3’ (36”) wide where depth exceeds 2’ (24”)
  - For **parallel** approach:
    - min. 5’ (60”) wide where depth exceeds 1.25’ (15”)

**Accessible Pedestrian Signals & Pedestrian Pushbuttons--R307 & R209.1 & R403**
The Technical Requirements...

**Forward Approach:**
Reach Ranges for Operable Parts

**UNCONFINED**
- 4' (48") D
- 2.5' (30") W

**CONFINED**
- >2' (24")

Accessible Pedestrian Signals &
Pedestrian Pushbuttons– R307 & R209.1 & R406

---

**Parallel Approach:**
Reach Ranges for Operable Parts

**UNCONFINED**
- 2.5' (30") D
- 4' (48") W MIN.

**CONFINED**
- >1.25' (15") D
- 5' (60") W MIN.
- Obstruction e.g. curb

Accessible Pedestrian Signals &
Pedestrian Pushbuttons– R307 & R209.1 & R406

---

The Technical Requirements...

Accessible Pedestrian Signals (APS)

Required, BUT......
Currently for IDOT the installation of APS & Pushbuttons depends on the following:

- Is it a Local Roads Project?
- Is it on a State Route?

If a Local Roads Project, follow Figure 41-6B in the BLR&S Manual
Install APS & accessible push button per MUTCD:
1) if work is done on the pedestrian signal involving the signal controller, or
2) the pedestrian signal head is replaced

However, BLRS 41-6.09 Pedestrian Street Crossings notes that if pedestrian signals are provided, they SHOULD be accessible pedestrian signals... perhaps there's some updates are needed.

If on a State Route, follow the memo from Director Osman dated July 31, 2013
Consider installation of APS per the guidance in the memo
The Technical Requirements . . .

Strongly considered if:

1. **Knowledge** of visually impaired person uses the crosswalk
2. **APS is requested** by a local agency or a person with a disability

Possibly considered if:

- High ADT on crossing street or low ADT on parallel street when peds are likely to be present
- Crosswalks across streets with speed limit > 45 mph
- Crosswalks > 120’ in length
- Ped clearance time sufficient to only cross from curb/shldr to a median requiring another pushbutton there
- Traffic signals use an exclusive pedestrian phase
- Crosswalks are located in intersection with > 5 legs
- It is a midblock location with a signalized crosswalk
- Crosswalks are both not perpendicular to the crossing street and not parallel to the adjacent street

AND:

**Written support** of local public agency is required prior to approving the use of APS

Installation & modernization costs of APS shall be shared with the local agency & maintained per the state/local agency traffic signal agreement
Other considerations with signals:

- Pole might not be compliant for location/reach.

  - If foundation of post is too large or too far from clear space, might need to design in an extension.
The Technical Requirements...

Clear Spaces—R404

Example of poor placement

APS & Pedestrian Pushbuttons—R307 & R209.1

The Technical Requirements...

Other considerations with signals:

If replacing existing curb ramps and crossings,

Consider if the pedestrian push buttons will need to be repositioned

- Designers – be mindful of reach changes to ped pushbuttons when redesigning curb ramps w/ traffic signals. Include pay items for button adjustment if making non-compliant
APS Resources:

- APS Guide at www.apsguide.org
- APS Guide at www.walkinginfo.org/aps
- On Access Board site at www.access-board.gov
  - Interfacing Audible Pedestrian Signals and Traffic Signal Controllers
  - Special Report: Accessible Public Rights-of-Way, Planning and Designing for Alterations (APS locations with various types of curb ramps)
  - APS case studies (coming soon)
- www.accessforblind.org
The Technical Requirements...

**Standards, Guidelines, Policies**

- Illinois Accessibility Code
- ADAAG (2010 Standards)
- PROWAG
- MUTCD
- BLRS/BDE Policy Manuals

On-Street Parking Spaces—R309

**The Technical Requirements...**

<table>
<thead>
<tr>
<th>Total Number of Parking Spaces</th>
<th>Minimum Number of Accessible Spaces</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off-Street (ADA)</td>
</tr>
<tr>
<td>1 to 25</td>
<td>1</td>
</tr>
<tr>
<td>26 to 50</td>
<td>2</td>
</tr>
<tr>
<td>51 to 75</td>
<td>3</td>
</tr>
<tr>
<td>76 to 100</td>
<td>4</td>
</tr>
<tr>
<td>101 to 150</td>
<td>5</td>
</tr>
<tr>
<td>151 to 200</td>
<td>6</td>
</tr>
<tr>
<td>201 to 300</td>
<td>7</td>
</tr>
<tr>
<td>301 to 400</td>
<td>8</td>
</tr>
<tr>
<td>401 to 500</td>
<td>9</td>
</tr>
<tr>
<td>501 to 1000</td>
<td>2% of total</td>
</tr>
<tr>
<td>1001 and over</td>
<td>20 plus 1 for each 100 over 1000</td>
</tr>
</tbody>
</table>

But....

On-Street Parking Spaces—R309 & R214

**The Technical Requirements...**

**Summary of Current Policy Application for Parking Space Requirements in Illinois**

<table>
<thead>
<tr>
<th>Policy</th>
<th>Off-street Parking</th>
<th>On-street Parking</th>
</tr>
</thead>
<tbody>
<tr>
<td>BDE</td>
<td>ADA</td>
<td>ADA</td>
</tr>
<tr>
<td>BLR&amp;S</td>
<td>ADA</td>
<td>PROWAG</td>
</tr>
<tr>
<td>IAC</td>
<td>ADA</td>
<td>NA</td>
</tr>
</tbody>
</table>

On-Street Parking Spaces—R309 & R214
The Technical Requirements . . .

**On-Street Parking**
Determined by counting the marked or metered spaces along the perimeter of a block

**Off-Street Parking**
Determined by counting the spaces within off-street lots; can combine lots available for specific purpose

On-Street Parking Spaces—R309 & R214

In determining requirements, cannot combine on-street parking with off-street parking

On-Street Parking Spaces—R309 & R214

The Technical Requirements . . .

Where adjacent s/w or ROW > 14’, provide min. 5’ wide access aisle

Parallel Parking Spaces/Wide Sidewalks—R309.2.1
The Technical Requirements...

Where adjacent s/w or ROW ≤ 14’, no access aisle is required. Locate space at end of block.

Parallel Parking Spaces/Narrow Sidewalks—R309.2.2

The Technical Requirements...

On-street:
Provide a min. 8’ wide access aisle.

Perpendicular/Angles Parking Spaces—R309.3

The Technical Requirements...

• Connect access aisles to PAR with curb ramp or blended transition
• do not need DW if not leading to a crosswalk

Curb Ramps or Blended Transitions—R309.4
The Technical Requirements . . .

Off-street
Provide 16' wide space
– two spaces cannot
share an access aisle

updated IAC 2018 502.3 now
“shall be permitted to share
common access aisle”

BDE 58-1.04, BLR&S 41-6.14
Need to be updated

The Technical Requirements . . .

Signs:
BDE does not indicate
specific horiz. or vert.
placement but does show
sign on Figure 58-1.C

The Technical Requirements . . .

Per AG’s
office, place
sign in center
of 16’ wide
space, &
between 5’-9’
above surface

(Note: IAC Sec. 502.6 Signs shall be vertically mounted on a post or wall at front center of the
parking space, no more than 6 feet horizontally from the front of the parking space and set a
minimum of 5 feet and a maximum of 9 feet from finished grade to the bottom of the R7-8 sign.)
**The Technical Requirements . . .**

Per BLR&S place sign 4’ from edge of parking space, min. 7’ above surface and no more than 2’ behind face of curb.

---

**On-Street Accessible Parking (MUTCD 3A.05-05)**

“When used, blue markings shall supplement white markings for parking spaces for persons with disabilities” but under:

38.20 Parking Space Markings

“Option:

Blue lines may supplement white parking space markings of each parking space designated for use only by persons with disabilities.”
Off-Street
Universal
Accessible Parking

Per IAC, a high quality yellow paint shall be used (IAC 502.3.3)

Questions

Miscellaneous Other Requirements
(Transit, Utilities, Protruding Objects)
The Technical Requirements...

Transit– Boarding & Alighting Areas in the ROW

- Level, stable surface
- Clear length of 8 feet min. perpendicular to the curb/street/hwy edge
- Clear width of 5 feet min.
- Grade measured parallel to the street can equal street grade
- Grade measured perpendicular to the street ≤ 2%

Boarding & Alighting Areas in the ROW

- Must be ≤ 2% in all directions
- If along street/track, slope parallel to street/track can be same as street/track grade
- Shall connect to streets/sidewalks with a PAR
- Bus shelters (PACE/CTA) for curbs 6” and lower do not require DWS. Curbs >6” considered a platform and require them to be installed.
The Technical Requirements . . .

Transit Shelters in the ROW

- Must connect to boarding area with a PAR
- Clear space required entirely in shelter:
  - At one end of the seat or
  - Not within 1.5’ of front of the seat
- Meet protruding objects requirements
- Environmental controls must be proximity actuated

The Technical Requirements . . .

Transit Shelters in the ROW

Carriage Walks

Do they need to meet PROWAG?
- If they do not lead to a crosswalk, NO, however, it should meet the width and cross slope requirements and end at the back of curb without a Curb Ramp as they are not intended to transport pedestrians from the sidewalk to the street but rather a vehicle similar to Bus Stops/Shelters.
- If they lead to a crosswalk, then it’s intended as a curb ramp, YES. Introduce curb ramps in that case.
The Technical Requirements . . .

Raised Shoulders/Path (barrier/mountable)
Do the shoulders need to meet PROWAG?
• If the shoulders are intended as the pedestrian accommodation, YES.
  • A good indicator in the absence of local agency coordination is if they have ramps at the corner street crossings.
  • We strongly encourage coordination with the local agency to make a determination if time allows.
• If no ramps exist, they are not required to meet PROWAG.
• Cycle tracks would require meeting bike requirements.

The Technical Requirements . . .

Can utilities be placed in the PAR or the ramp?
Yes, but if possible try to relocate.

The Technical Requirements . . .

27” < Objects ≤ 80”
4” maximum protrusion
Applies to entire pedestrian circulation path.
1-DETERMINE IF THE RUNNING SLOPE OF YOUR CURRENTLY PROPOSED RAMP IS UNDER 8.3%, IF SO THEN LABEL THE RUNNING SLOPE

\[ L_{\text{RAMP}} = 5.88' \quad X_{\text{RT}} = 2' \quad X_{\text{LT}} = 0' \]

\[ RS_{\text{RT}} = \frac{9.52}{(618.04 - 618.08) / 5.88\times 100} \]

\[ RS_{\text{LT}} = \frac{9.01}{(618.47 - 617.94) / 5.88\times 100} \]

(CIRCLE ONE) — MEETS / DOES NOT MEET THE 8.3% MAX RUNNING SLOPE?

2-DETERMINE YOUR DESIGN RAMP LENGTH:

\[ L = ? / 7.14% \]

MAKE AN ASSUMPTION ON HOW HIGH YOU WANT YOUR RAMP TO GO UP, SAY 6" (B-6.12 CC&G)

\[ L = ? \text{ feet} \]

3-DETERMINE THE TOP RT ELEVATION USING A B-6.12 CC&G

\[ \text{PR ELEV}_{\text{BOC}} = \text{EX. ELEV}_{\text{EOP}} + (-W_{\text{GUTTER}} * 5% + 0.5') / 12) \]

\[ \text{PR ELEV}_{\text{TOP RT}} = \text{PR ELEV}_{\text{BOC}} + X * 1.5\%_{\text{LOWER LANDING}} + 7.14\% * L \]

\[ \text{PR ELEV}_{\text{BOC RT}} = \frac{618.04}{0.60} \]

\[ \text{PR ELEV}_{\text{TOP RT}} = \frac{618.05}{0.03} + \frac{2' * 1.5\%_{\text{LOWER LANDING}} + 7.14\% * L}{0.50} \]
ADA/PROWAG CLASS PROBLEM

4-REPEAT WITH OTHER EDGE
PR ELEV<sub>SO</sub> L = 617.95 + (- 12") * 5% + 0.5") / 12

PR ELEV<sub>SO</sub> L = 617.94

PR ELEV<sub>TOP</sub> L = 617.94 + 0 * 1.5% (LOWER LANDING) + 7.14% * 7

PR ELEV<sub>TOP</sub> L = 618.44

5-DETERMINE IF X-SLOPE IS < 2% (1.5% PREFERRED) ASSUMING A 5-FOOT SIDEWALK AND THE SIDE STREET HAS NO YIELD/STOP CONTROL.
IF NOT, THEN YOU'LL NEED SOME RE-DESIGN OF SW DEPENDING ON HIGH/LOW KEEPING IN MIND YOUR RUNNING SLOPE
PR ELEV<sub>BT</sub> L = 617.94'  PR ELEV<sub>BT</sub> R = 518.08'

XS BOTTOM GRADE BREAK = 2.8\% (CIRCLE ONE) - MEETS / DOES NOT MEET THE MAX CROSS SLOPE
(C618.08 - 617.94) / 5' x 100

XS TOP GRADE BREAK = 2.8\% (CIRCLE ONE) - MEETS / DOES NOT MEET THE MAX CROSS SLOPE
(C618.58 - 618.44) / 5' x 100

6-SAY IT WAS NOT COMPLIANT THEN RE-DESIGN TO HAVE MAX 1.5% XS:
PR ELEV<sub>TOP</sub> L = PR ELEV<sub>TOP</sub> R +/- W*1.5\% (W-TYPICALLY 5)

PR ELEV<sub>TOP</sub> L = 619.58 + /- 5' * 1.5\% (W-TYPICALLY 5)

PR ELEV<sub>TOP</sub> L = 619.51 \rightarrow RS = (618.51 - 617.94) / 7' x 100 \rightarrow RS = 8.14\% < 8.33\% \text{ (CIRCLE ONE)}

IF YOU ADD (I.E. RAISE ELEVATION) YOUR ELEV<sub>TOP</sub> L = 618.66 WHICH

RESULTS IN A RUNNING SLOPE OF:
(C618.66 - 618.44) / 7' x 100 = 10.29\% > 8.33\% \text{ (DOES NOT MEET )}

7-Figure out the corners of your turning space:
SELECT YOUR TOP LANDING DIMENSIONS @ 1.5\% Pref (2%MAX) in all directions
(SELECT ONE)
- 4'x4'
- 4'x5'
- 5'x5'

ADJACENT SIDEWALK WOULD ALSO BE DESIGNED TO 5' WIDTH POLICY.

(CIRCLE ONE) - IS THE UPPER LANDING CONTRAINED OR UNCONTRAINED?

(add) PR ELEV<sub>TOP</sub> Rt BK = 618.58 + 5' * 1.5\%  

PR ELEV<sub>TOP</sub> Lk BK = 618.51 + 5' * 1.5\%

PR ELEV<sub>TOP</sub> Rt BK = 618.59

7-FINAL DESIGN:

ELEV<sub>TOP</sub> Rtk = 618.66  ELEV<sub>TOP</sub> Lk = 618.58  ELEV<sub>BT</sub> Rtk = 618.08  ELEV<sub>TOP</sub> l = 618.59

RS<sub>RT</sub> = 8.14\%  RS<sub>L</sub> = 8.02\%  XS<sub>BL</sub> = 7.14\%  RS<sub>BL</sub> = 2.27\%

ELEV<sub>TOP</sub> Lk = 618.51  ELEV<sub>BT</sub> Lk = 617.94  ELEV<sub>TOP</sub> l = 617.95
For pedestrian facilities that cannot be constructed fully compliant and for which there is no approved BDE 3101 ADA Statement of Maximum Extent Practicable, check off area(s) of non-compliance, discuss barriers to compliance and proposed construction to achieve ADA compliance to the maximum extent practicable. Return the form to the district ADA coordinator for concurrence on proposed construction.

<table>
<thead>
<tr>
<th>Job Number</th>
<th>Contract Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>C-91-145-11</td>
<td>60M61</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Route</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAP 330</td>
<td>103R-4</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intersection/Station</th>
<th>Quadrant</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sta. 270+00 Lt.</td>
<td>West side of US 45 (LaGrange Road)</td>
</tr>
</tbody>
</table>

- [ ] Curb ramp running slope
- [ ] Curb ramp width
- [ ] Landing/turning space dimensions
- [ ] Truncated dome orientation
- [ ] Pedestrian push button reach range

- [ ] Curb ramp cross slope
- [ ] Gutter counter slope
- [ ] Landing/turning space cross slope
- [ ] Grade break orientation
- [ ] Other

Discussion of barrier(s) to full ADA compliance and proposed maximum extent practicable design:

IDOT purchased ROW and Temporary Easement to widen and reconstruct US 45. As a part of the land acquisition agreement, IDOT will restore Rich Realty's parking lot. See attached detailing the slopes in the parking lot at Rich Realty located on the west side of US 45 (LaGrange Road) between 143rd Street and 144th Place in Orland Park, IL. The plans call for an ADA accessible space but due to the existing grades and minimal distance between the commercial building and State ROW, the accessible parallel parking space is not ADA compliant. There is a 5 foot sidewalk running along the parking lot that is ADA compliant. We have explored moving the accessible parking to the middle of the three stalls, however doing so will not achieve the desired parking lot cross slopes. Please confirm that the accessible parking space can be designated as shown in the plans at a slope greater than 2% with an accessible ADA compliant sidewalk adjacent to the parking space.

Resident Engineer/Technician

District ADA Coordinator

Date submitted 07/30/16

Date concurred
ADA Statement of Maximum Extent Practicable

Route: FAU 3730  
Street: Halsted Street  
Marked: IL 1  
Contract #: 60T20  
State Job #: P-91-228-11

Section: 3262N-1  
County: Cook  
Municipality: Harvey/Phoenix

Project Limits: at Vincennes Road

Project Length: 0.52 mile

Estimate of Cost: $6,900.00  
Type of Project (e.g. SMART, 3R, Reconstruction): 3R

Brief Project Description: Channelization/Traffic Signal Modernization/Drainage

DOCUMENTATION OF MAXIMUM EXTENT PRACTICABLE (MEP)

Location(s) where MEP is Requested:  
Halsted St. (Sta. 46+73, Rt. Side), Halsted St. (Sta. 49+11, Rt. Side)

Design Element for which MEP is Requested and Proposed Design Value:  
Cross slope of the lower landing varies from 5.0% to 10.6%.

Design Element Policy Value:  
Maximum cross slope of lower landing is 2%.

Coordination Meeting Date: 06/15/2016  
Prepared By: Farhan Tariq (IDOT, D1-Design)  
Date: 05/31/2016

Specify and Explain Reason(s) why Full Compliance is Infeasible:  
☒ Topography (e.g. steep existing road grade exceeds ADA compliant maximum)
☐ Structural (e.g. bridge beams, buildings, basements, foundations)
☐ Historic Preservation (e.g. historic buildings, districts, monuments)
☐ Utilities (Project scope would not otherwise require utility relocation)
☐ Right-of-Way (Project scope would not otherwise require R.O.W.)
☐ Other

Discuss Alternatives Considered (Attach supporting documentation, e.g. plan and profile sheets, photos):  
See Attachment A

APPROVAL/DISAPPROVAL

BDE Approval Date:  
BDE Disapproval Date:  
BDE Comments on Disapproval: 
ADA Maximum Extent Practicable
Attachment A

Description of Situation:

For Halsted St. (Sta. 46+73, Rt. Side), which is located in the portion of the project that is to be resurfaced only, by installing ADA compliant depressed curb and gutter and with the existing sidewalk restricted on the east side due to the adjacent property, the proposed cross slope exceeds the maximum value of 2.0% as mentioned in section R304.5.3 of the Proposed Accessibility Guidelines for Pedestrian Facilities in the Public Right-of-Way (PROWAG).

The curb ramps at Halsted St. (Sta. 49+11, Rt. Side) are located next to a driveway that has a cross slope that is greater than 2%. With this area being in the portion of the project that is to be resurfaced only, the elevations at the edge of pavement and back of the driveway are fixed resulting in the proposed cross slope exceeding the maximum value of 2.0% as mentioned in section R304.5.3 of the Proposed Accessibility Guidelines for Pedestrian Facilities in the Public Right-of-Way (PROWAG).

Approval of an ADA Statement of Maximum Extent Practicable (MEP) is requested for the cross slope of the lower landing.

Alternatives Considered:

1. For Halsted St. (Sta. 46+73, Rt. Side), the option to lower the east sidewalk was considered. This option was not selected because this would require constructing additional stairs leading to the adjacent property which would be outside the scope of project.

2. For Halsted St. (Sta. 49+11, Rt. Side), consideration was given to provide a 4’ section of sidewalk that would meet cross slope requirements through the driveway (thereby effecting the ramps as well); however, this was not selected because the shared-use path in this section must be 8’ wide and this change would also result in the driveway exceeding commercial driveway grade requirements.

Benefits of Proposed Design:

The proposed design effectively takes into account other factors affecting the project such as adequate roadway cross slope, driveway grade and drainage, while minimizing non-compliance of ADA requirements.
Halsted St. (Sta. 46+73, Rt. Side)
To: All Designers

From: Ken Eng

Subject: ADA Ramp Details for Contract Plans

Date: January 10, 2018

In order to comply with the Department’s Policy for American with Disabilities Act (ADA) ramp construction within the project limits, all contract plans with ADA ramps will require project specific ADA ramp construction details for the contractor. This will apply to all projects (resurfacing, pavement widenings, bridges, and reconstructions) that has existing or will have proposed accommodations for ADA.

ADA ramp construction details should follow the templates provided. Templates have been separated into resurfacing/stand-alone ADA contracts and widening/reconstruction contracts. The widening/reconstruction templates closely resemble the ADA templates that are provided in new phase 1 reports. The widening/reconstruction templates use a station, offset, slope, and elevation format since an accurate centerline and alignment is available for these projects. The resurfacing/stand-alone ADA templates use a distance, slope, elevation, and reference point format. Since an accurate centerline is not available on resurfacing/stand-alone ADA projects it is essential to provide 2 reference points at each corner to establish control.

Where an ADA ramp facility cannot be made fully compliant, the designer must complete a Maximum Extent Practicable (MEP) Form (BDE Form 3101) discussing barriers to full compliance and alternative design considered. As part of completing BDE Form 3101 an attachment with the description of the situation, alternatives considered, benefits of the proposed design, plan sheet with completed ADA ramp design and design variance circled, and pictures (if available) should be provided. This should be processed through the District’s ADA coordinator for further handling.

Information pertaining to the design of the ADA ramps can be found in Chapter 58 of the Bureau of Design and Environment Manual and within the Department’s Accessible Public Right of Way Field Guide. Both are on the IDOT website.
All Designers  
January 10, 2018  
Page two  

The following is additional guidance for designers:

1) Please read all of the notes in the ADA templates before beginning design.

2) The scale and size of text shown on the ADA templates is for IDOT District 1 Workstations. Please ensure text and details are visible on an 11x17 pan sheet. Revise text size as necessary for clarity.

3) At the start of contract plan preparation a request for ground survey of existing locations should be made. For Bureau of Design In-house designers, prior to submitting the survey request the designer must check the ADA GIS map to ensure that there is no overlap of ADA survey/design with a standalone ADA contract.

4) Please submit an environmental survey request for special waste at the same time the ground survey request is submitted. Quantities for special waste can be estimated at this time and revised when design is complete if the initial estimates are inaccurate. Typically 150 to 250 square feet of sidewalk removal and replacement will occur per corner, but can vary significantly based upon existing field conditions.

5) Earth excavation is typically estimated at .01 cubic yard per 1 square foot of sidewalk for when the ground is flat and sidewalk is placed over compacted subgrade. If subbase is installed increased quantity accordingly.

6) Please remember to look out for bus stops when designing ADA curb ramps to ensure that pedestrians have access to bus stops. Coordinate with PACE through IDOT project manager if there are conflicts with existing bus pads or shelters. Preference is to avoid relocation whenever possible.

7) Coordinate with the local municipality through the IDOT project manager if benches need to be relocated or removed.

8) Please maintain brick sidewalks if existing conditions have brick pavers. Coordination with the local agency may be needed. Brick pavers shall meet ADA and PROWAG standards.

9) For pedestrian push buttons outside of the 30"-42" vertical requirement please add the pay item relocate existing pedestrian push button. The proposed push button should be at 36". In addition to the vertical requirements for pedestrian push buttons please ensure pedestrians can horizontally reach the pedestrian push buttons. The front of the push button shall not be further away than 10" from the paved surface. Currently extensions for the push button are manufactured in 6", 12", or 18" variants. Generally maintenance transfer of the traffic signal is not required for relocation of pedestrian push buttons, but confirm with IDOT project manager.
10) Sidewalk design should allow pedestrians to access push-buttons. Need to have a 2.5'x4' paved clear space. No new poles will be added on resurfacing or stand-alone ADA contracts. The recommendation is to have the push button be parallel to the crosswalk.

11) If handholes are impacted please choose the pay item rebuild existing handhole and not the pay item adjust existing handhole as handholes cannot be adjusted. Please remember to add the District 1 special provisions rebuild existing handhole, handholes, and maintenance of existing traffic signal installation. If handhole is located in the existing median that is being converted to a striped median a pay item “rebuild existing handhole to heavy duty handhole” shall be used. Please also add the pay item maintenance of existing traffic signal installation for each signalized intersection impacted.

12) Please note that utilities within the curb ramp should be relocated whenever possible, but if it is not possible then it is acceptable to leave the utility under the curb ramp as long as ADA/PROWAG requirements are met. The detectable warning portion must be free of any utilities such as handholes or frames and lids. If the detectable warning location does not meet PROWAG requirements then a MEP is required.

13) Please remember to look out for water supply valve/buffalo boxes that may need to be relocated as part of the ADA design. 6" valve boxes and valve boxes with a 24" frame and lid are not listed in the status of utilities special provision as the corresponding pay item is provided in the plans for the contractor to adjust. The plans or ADA details must call out the locations of valve box adjustments in the sidewalk. Whenever these valve boxes are in the pavement the special version of the pay item should be used. When in the sidewalk the regular version should be used. Please also remember to coordinate any fire hydrants that may need relocation or adjustment. This is generally listed as a utility conflict but can be done as part of the contract at the local agency cost.

14) If any pedestrian ramps are to be removed due to safety concerns please coordinate with the District 1 Bureau of Traffic Bike and Pedestrian Engineer and Local Agency through the IDOT project manager.

15) Please add the pay item Construction Layout (Special) and the special provision Construction Layout Special for Resurfacing with ADA and Stand-Alone ADA (D-1). If project scope requires more construction layout than just the ADA curb ramps please use the pay item Construction Layout and corresponding special provision. Choose either pay item Construction Layout (Special) or Construction Layout, but not both pay items.
16) Please add the pay item Detectable Warnings (Special), District Detail BD-58, and the special provision Detectable Warnings (Special) in City of Chicago (D-1) for any curb ramp improvements within the City of Chicago to ensure cast iron detectable warnings are used.

17) If during the field visit it is determined that the only element of the ADA curb ramp that is not compliant are the detectable warnings then a specific ADA detail is not required for that curb ramp. A plan sheet callout indicating ADA detectable warning replacement can be provided along with the corresponding quantities of detectable warnings and sidewalk removal and new PCC sidewalk.

18) Please provide a callout or asterisk on the plan sheet indicating each location that will have an ADA curb ramp improvement on resurfacing contracts.

19) Please remember to follow the 15-foot rule for curb ramps and transition segments. Please refer to the attached exhibit for guidance.

20) Patching should only be shown on the ADA details if changes to the cross slope of the roadway are required. Otherwise do not show patching on the ADA details but include a quantity for patching. Generally 4-foot wide patches are recommended based upon the minimum roller size to achieve compaction. Length of the patch should be the length of the curb to be removed.

21) Ensure that water flows off of sidewalk and towards grass or curb and gutter to prevent ponding. Please note locations of inlets for new construction/reconstruction as inlets should not be in PAR. Add pay item lids, type 1, open lid and IDOT Highway Standard 604001 for frame and lids within the depressed curb of the curb ramp.

22) Please add the general note “The contractor shall maintain pedestrian access at all times during construction.”

23) If the running slope of a ramp is less than 5%, an upper landing is not required. A transition segment is not considered an upper landing. Therefore no MEP is required if the cross slope of a transition segment exceeds 2%.

24) MEPs are not required for the lower landing area transitioning from a 2% cross sloped ramp to a 5% cross sloped crosswalk at a traffic signal. MEPs are also not required on transition segments when connecting an altered compliant element to an existing element.

25) MEPs will not be approved for alternative pedestrian routes during construction during the planning and design phase. Generally MEPs will not be approved for reconstruction projects.
26) MEP forms are reviewed by BDE at the same time as the Monthly FHWA meeting. To have your forms reviewed in a timely manner please ensures that MEP forms are emailed to the District ADA coordinator 2 weeks in advance of the FHWA meeting. Email address for the District ADA coordinator is DOT.D1.ADA@illinois.gov. After approval, the District ADA coordinator will email the Bureau of Programming’s Geometrics Unit Head and central office BDE requesting that the MEP forms be reviewed by BDE at the next MEP meeting.

27) Approved MEPs need to be provided to the resident engineer at the preconstruction meeting.

If you have any questions, please contact Fawad Aqueel, Plan Preparation Engineer, at 847-705-4247.

cc: Issam Rayyan
    Lisa Heaven Baum
15 FT RULE (R304/BD58-1.09h)

"The running slope of the curb ramp shall be 5% minimum and 8.3% max but shall not exceed the ramp length to exceed 15 FT."

In a, there is no max length of curb ramp if using 8.3% max; however, to avoid "chasing the existing grade" indefinitely, when the 8.3% max exceeds 15 FT, you can alternately utilize a max length of 15 FT and utilize any grade desired.

1DOTS Highway Standard requires level (6a, 2% max) upper and lower landings. PRODAG allows the lower landing to meet 5% or the grade of the road and does not require an upper landing. Under the 15 ft rule, provision of an upper landing is up to designer's discretion.

NOTE 1: After the landing use slope requirements for:
SIDEWALK / SIDEWALK (R302.5/BD58-1.06)

"Grades shall not exceed the GENERAL GRADE OF ADJACENT STREET. Where PAR is not contained within a street or highway ROW the grade of the PAR shall be 2% MAX." OR TRANSITIONAL SEGMENTS (R203.3.2):

Beyond the landing, you are allowed to have a transition zone into the existing sidewalk/path, use engineering judgment to provide the ADA/PRODAG requirements to the maximum extent practicable. This transition zone does not require a Maximum Extent Practicable Form (BED 301) or a Construction Concurrence Form (BED 580). As a matter of engineering judgment only, you may use the sidewalk ramp grades shown below.

SIDEWALK RAMP (R407/BD58-1.08b) (I.E. NOT CURB RAMP)

• The 15 FT rule does not apply to Sidewalk Ramps
• Running slope between 5% and 8.3% for new facility, Existing facilities can use the following:
  - Max Rise: 6' in 100' or 6% max
  - Max Rise: 2.5' in 100' or 2% max
• Requires 5 FT level landings at top and bottom
• The max vertical rise shall be 2.5 FT 130 IN, after which a 6 FT landing is required prior to introducing another ramp to reach desired elevation
• Requires handrails if vertical rise is > 6' IN or length > 12" IN
  - However, avoid the use of handrails whenever possible

NOTE 2:
If the curb ramp running slope is < 5%, no landing is required unless a turning space is required for an intersecting sidewalk.

NOTE 3:
All slopes shown in this exhibit are running slopes.
ADA DETAILS FOR RESURFACING AND ADA STAND ALONE CONTRACTS

FOR DESIGNER REFERENCE:
1.) THESE ADA DETAILS ARE FOR ILLUSTRATIVE PURPOSES, REFER TO BDE MANUAL AND ADA/PROWAG GUIDELINES FOR DESIGN REQUIREMENTS.
2.) FOR RESURFACING /ADA STAND ALONE CONTRACTS, A MINIMUM OF 2 REFERENCE POINTS PER CORNER MUST BE PROVIDED. REFERENCE POINTS CANNOT BE IN LOCATIONS TO BE REMOVED. TYPICALLY PROVIDE AT END OF SIDEWALK REPLACEMENT.
3.) EXISTING DISTANCE TO EACH REFERENCE POINT MUST BE PROVIDED.
4.) FOLLOW LEGEND FOR LABELING EXISTING ELEVATIONS, SLOPES, AND LENGTHS. PROVIDE ELEVATIONS AT GRADE BREAKS. BENCHMARKS MUST BE INCLUDED.
5.) DO NOT SHOW LOCATIONS OF PATCHING, BUT INCLUDE IN QUANTITIES AS REQUIRED. 4 FT WIDE FULL DEPTH PATCHES RECOMMENDED.
6.) IF ADA/PROWAG REQUIREMENTS CANNOT BE MET BY MODIFYING OTHER DESIGN ELEMENTS, AS A LAST OPTION YOU CAN MODIFY CURB GUTTER FLAG SLOPE FROM -5% TO +5% TO GET CROSS SLOPE BELOW 2%, BUT MAKE SURE GUTTER WATER FLOWS AWAY OR TO EXISTING STRUCTURES. IF THIS IS PURSUED, ADD ELEVATIONS AT EDGE OF PAVEMENT, FLOW LINE, AND BACK OF CURB AS REQUIRED.
7.) FOR RESURFACING /ADA STAND ALONE CONTRACTS AND PAY ITEM : CONSTRUCTION LAYOUT (SPECIAL), LSM 1.
8.) QUANTITIES CAN BE SHOWN ON DETAIL OR PROVIDE SCHEDULE OF QUANTITIES.

REFERENCE BENCHMARK ELEV 935.23
BENCHMARK - PK NAIL IN CENTERLINE OF IL 47
LOCATION : 57 FT SOUTH OF 3RD AVENUE

REFERENCE BENCHMARK ELEV 856.66
BENCHMARK - 7" CUT ON NORTH WESTERNLY LOWER FLANGE BOLT OF HYDRANT
LOCATION : ON NORTH WEST CORNER OF IL ROUTE 23 AND FOREST STREET

FOR RESURFACING / ADA STAND ALONE CONTRACTS

STATE OF ILLINOIS
DEPARTMENT OF TRANSPORTATION

REPLACE W/ TOPSOIL & SOD
EXISTING SIDEWALK
PROPOSED PROFIL
REPLACE WATERPOO50 & 500
EXISTING ELEVATION/SLOPE
PROPOSED SIDEWALK
EXISTING LENGTH
DETECTABLE WARNINGS
FOR DESIGNER REFERENCE:
1.) THESE ADA DETAILS ARE FOR ILLUSTRATIVE PURPOSES, REFER TO BDE MANUAL AND ADA/PROWAG GUIDELINES FOR DESIGN REQUIREMENTS.
2.) FOLLOW LEGEND FOR LABELING EXISTING ELEVATIONS, SLOPES, AND LENGTHS.
3.) FOR RECONSTRUCTION/WIDENING CONTRACTS ADD PAY ITEM 10003 FOR CONSTRUCTION LAYOUT ISSM 2.
4.) FOR RECONSTRUCTION/WIDENING CONTRACTS PROVIDE STATION OFFSETS.
5.) ESTABLISH STATION/OFFSETS BASED UPON MAIN LINE ALIGNMENT.
6.) SHOW EXISTING PROPOSED ABOVE GROUND UTILITIES AND SIGNS.

STATE OF ILLINOIS
DEPARTMENT OF TRANSPORTATION

FILE NAME: D:\dot016isi1xc1.illinois.gov\D1\Users\PENCEPL\My Documents\ADA Standards\Typical-ADA-sht-plan.dgn
USER NAME = PLOT DATE = 1/10/2018
SCALE = 10.0000 ' / in.
PLOT SCALE =
PLOT DATE =
DATE DESIGNED =
CHECKED =
DRAWN =
REVISED =
REVISED =
REVISED =
REVISED =

<<PROJECT ROAD>> - <<PROJECT LIMITS>>
SIDEWALK DETAIL PLAN
SHEET OF SHEETS
STA. TO STA.

LEGEND
\E X I S T I N G E L E V A T I O N / S L O P E
\E X I S T I N G L E N G T H
\P R O P O S E D S I D E C U R N
\D E T E C T A B L E W A R N I N G S
\R E P L A C E W I T H T O P S O I L & S O D

S I D E W A L K D E T A I L P L A N
S I D E W A L K R E M O V A L

FOR RECONSTRUCTION/WIDENING CONTRACTS ADD PAY ITEM 10003 FOR CONSTRUCTION LAYOUT ISSM 2.

FOR RECONSTRUCTION/WIDENING CONTRACTS PROVIDE STATION OFFSETS.

ESTABLISH STATION/OFFSETS BASED UPON MAIN LINE ALIGNMENT.

SHOW EXISTING PROPOSED ABOVE GROUND UTILITIES AND SIGNS.
NOTES:
1) TABLES ARE AN ACCEPTABLE ALTERNATIVE FOR RESURFACING AND ADA STAND ALONE CONTRACTS.

REFERENCE BENCHMARK ELEV 935.33
BENCHMARK = PK NAIL IN CENTERLINE OF IL 47
LOCATION: 57 FT SOUTH OF 3RD AVENUE

REFERENCE BENCHMARK ELEV 856.66
BENCHMARK = "X" CUT ON NORTH WESTERNLY LOWER FLANGE BOLT OF HYDRANT
LOCATION: ON NORTH WEST CORNER OF IL ROUTE 23 AND FOREST STREET

LEGEND

EX. ELEV. = EXISTING ELEVATION/SLOPE
PR. ELEV. = PROPOSED ELEVATION/SLOPE

REFERENCE BENCHMARK ELEV 935.33
BENCHMARK = PK NAIL IN CENTERLINE OF IL 47
LOCATION: 57 FT SOUTH OF 3RD AVENUE

REFERENCE BENCHMARK ELEV 856.66
BENCHMARK = "X" CUT ON NORTH WESTERNLY LOWER FLANGE BOLT OF HYDRANT
LOCATION: ON NORTH WEST CORNER OF IL ROUTE 23 AND FOREST STREET

STATE OF ILLINOIS
DEPARTMENT OF TRANSPORTATION

LEGEND

EX. ELEV. = EXISTING ELEVATION/SLOPE
PR. ELEV. = PROPOSED ELEVATION/SLOPE

REFERENCE BENCHMARK ELEV 935.33
BENCHMARK = PK NAIL IN CENTERLINE OF IL 47
LOCATION: 57 FT SOUTH OF 3RD AVENUE

REFERENCE BENCHMARK ELEV 856.66
BENCHMARK = "X" CUT ON NORTH WESTERNLY LOWER FLANGE BOLT OF HYDRANT
LOCATION: ON NORTH WEST CORNER OF IL ROUTE 23 AND FOREST STREET

STATE OF ILLINOIS
DEPARTMENT OF TRANSPORTATION
NOTES:
1) THESE ADA DETAILS ARE FOR PRESENTATION PURPOSES. REFER TO THE CURRENT SIDE MANUAL AND ADA/PROWAG GUIDELINES FOR DESIGN REQUIREMENTS.
2) FOLLOW LEGEND FOR LABELING EXISTING ELEVATIONS, SLOPES, AND LENGTHS.
3) ESTABLISH STATIONS/OFFSETS BASED ON 1 CENTERLINE FOR EACH CORNER.
4) PROVIDE STATIONING FOR POINTS "S" AND "T" (OR "Q" & "R") ON BOTH AXES IN ORDER TO CONFIRM THEY MATCH WITH THEIR ASSOCIATED PROFILE.
5) DO NOT DESIGN TO THE MAXIMUM ALLOWABLE CROSS-SLOPES AND RUNNING SLOPES SO AS TO ALLOW FOR CONSTRUCTION TOLERANCES.
6) SUBMIT PLANS SIZED AT 1"=20' (FULL SIZED) OR 1"=10' (11x17). 1 OR 2 RADII OF RETURN SHOULD BE PROVIDED PER SHEET.
7) IF PARALLEL SIDEWALK SLOPES DO NOT MATCH, LABEL BOTH SLOPES. FOR EXAMPLE, IF H-G DOES NOT MATCH E-D, BOTH SLOPES SHOULD BE LABELED.
GEOPAK Height / Slope Query Tool

1) Preconditions:
   • Digital Terrain Model (DTM) generated from survey data.
   • TIN File: File where the triangulated model is stored in binary format. A TIN extension is assumed for the binary file containing the triangulated model.

2) DTM Tools: GEOPAK Menu -> ROAD -> DTM Tools

3) Analysis (second to last icon): Height / Slope
4) **Height / Slope**

![Image showing Height / Slope options]

5) **Load .tin file**. Located (typically) in GPK folder of your project:
P(D)123456 -> CADData -> GEOPAK Project Mgr -> GPK

![Image showing Open TIN File dialog]

6) **Plan View Coordinates, Elevation, and Slope** of the triangulated model can be queried:

![Image showing Height / Slope options with Display Only]

Turn on **Display Only**, if you do not want the data drawn into the MicroStation file.

Mode: **Elevation** -> elevation at any point within the boundary of the triangulated model.

Mode: **Slope** -> slope between (any) two points within the boundary of the triangulated model.
Section 504 (49 CFR Part 27) of the Rehabilitation Act of 1973 (29 USC 794), the Illinois Environmental Barriers Act (410 ILCS 25/1), and Title II (28 CFR Part 35) of the Americans with Disabilities Act (ADA) of 1990 (42 USC 12131) prohibit discrimination on the basis of disability by public entities. To that end, the Department must ensure newly constructed facilities, and existing facilities being altered, are accessible to the disabled.

The ADA accessibility criteria is presented in Chapters 58 and 31, as well as the various Federal and state ADA standards that are applicable whenever pedestrian access, circulation, or use is affected, or could be affected, by a project. As described in the BDE Manual Section 58-1.01(b), newly constructed facilities and elements added to existing facilities must be fully compliant with the criteria. However, existing elements that are altered must comply with the criteria to the maximum extent practicable within the scope of the project. This typically means that alterations must also be fully compliant unless there are existing physical constraints or qualified historic facilities which make full compliance impracticable.

As part of the ADA Transition Plan, each district is responsible to have an inventory of non-compliant facilities and demonstrate a movement towards compliance each year after the plan is released. Facilities are defined as all sidewalks, curb ramps, crosswalks (marked and unmarked), pedestrian traffic signals, weigh stations and rest stops. A yearly ADA Transition Plan Inventory Report is required by each district, documenting facilities that are non-compliant and demonstrating yearly progress.
This memorandum will establish additional procedures to be carried out by the District One Bureaus of Local Roads and Streets, Programming, Design, Construction, and Traffic Operations to monitor our district’s inventory compliance on State Highways:

1. **New Projects** - Staff in the Bureaus of Local Roads and Streets, Traffic Operations Permit Section, Programming and Design shall be responsible for filling out a new District form called the “ADA Project Alert” (D1 PD0038). This form will inform the District One ADA Coordinator about new projects that could potentially alter or propose facilities within the State right-of-way (ROW). These new project forms will be recorded in the ADA Inventory Database by the District ADA Coordinator or the Bureau of Programming’s designated staff for future inquiry documentation and/or follow up.

   During the Pre-Construction meeting, any Maximum Extent Practicable forms shall be given to the Construction resident engineer/technician for their information and records.

2. **ADA Inspections** - The Bureau of Construction’s resident engineers/technicians, Local Roads and Streets’ field engineers, and/or Traffic Operation Permit Section’s engineers overseeing any improvement or permit which alters the facilities in the public ROW shall be responsible for filling out, or cause to fill out, an “ADA/PROWAG Inspection Form” (D1 PD0031) for each facility being altered. These forms shall be kept in their Bureau’s project file in compliance with the Document Management Manual document retention schedule for future proof of inspection and compliance.

3. **Final Inspections** - At the completion of the project’s construction, staff in the Bureaus of Local Roads and Streets, Construction and/or Traffic Operations shall be responsible for filling out a new District form called “ADA Inspection Summary” (D1 PD0039) as part of the project close out documentation. This form will document the compliance of all facilities that were altered or created in the State ROW. These forms shall be transmitted to the Bureau of Programming to record these changes in compliance. The District’s ADA Coordinator or the Bureau of Programming’s designated staff will record these changes in the ADA Inventory Database for future inquiry documentation and/or follow up.

4. **Non-Compliance** - Those facilities that are proposed to be altered but are not able to be made ADA/PROWAG compliant within the scope of the project shall be discussed at the BDE/FHWA district coordination meetings by the bureau responsible for the alteration.
Staff shall clearly demonstrate that compliance is not feasible, document what will otherwise be done to apply the ADA standards to the maximum extent practicable, and complete the "ADA Maximum Extent Practicable Form" (BDE 3101) attaching any supporting documentation.

The documentation in the maximum extent practicable request will vary on a case-by-case basis; however, cost is not a factor. The FHWA and BDE representatives will evaluate the documentation and determine whether or not the element is designed to the maximum extent practicable. If approved, those facilities will be added to the District's ADA Transition Plan Inventory Database until the non-compliant element is improved to full compliance. During the Pre-Construction meeting, any Maximum Extent Practicable forms shall be given to the Construction resident engineer/technician for their information and records.

Projects currently under construction that encounter a facility that cannot be made ADA/PROWAG compliant and for which a Maximum Extent Practicable form was not approved prior to construction must fill out the "ADA Construction Concurrence" (BDE 5801) form with any supporting exhibits/documentation. This form will be submitted to the District ADA Coordinator who along with the Designer can work with the Construction resident engineer/technician to determine the best maximum extent practicable alternative to use in construction.

Resident engineers/technicians and their contractors must identify the non-compliance issues early to avoid incurring additional project costs or redoing work. The contractor shall be made responsible for bringing all facilities to compliance or provide proper justification as outlined above. BDE 5801 will be retained in the project file as record against future complaints and documented in the ADA Transition Plan Inventory Database.

5. Permit Projects - Any permits within incorporated municipalities which alter facilities in the State ROW shall require the Bureau of Traffic Operation's Permit Section staff, or their designated local agency, to be responsible submitting the "ADA Project Alert" (D1 PD0038) and any "ADA Maximum Extent Practicable" (BDE 3101) forms with supporting documentation/approval to the Bureau of Programming after the permit has been issued/approved by the Permit Engineer.

Permit projects under construction that encounter a facility that cannot be made ADA/PROWAG compliant and for which a Maximum Extent Practicable form was not approved prior to the permit approval must fill out the "ADA Construction Concurrence" (BDE 5801) form with any supporting exhibits/documentation. This form will be submitted to the District ADA Coordinator who along with the Permit Engineer can work
with the permit applicant to determine the best maximum extent practicable alternative to use in construction.

The permit applicant shall be made responsible for bringing all facilities to compliance or provide proper justification as outlined above. Once the permit's construction has been completed, the "ADA Inspection Summary" (D1 PD0039) form and any required "ADA Construction Concurrence" (BDE 5801) forms with supporting documentation, shall be submitted to the Bureau of Programming to update the ADA Transition Plan Inventory Database.

If facilities are altered in the State ROW within unincorporated areas, the developer or permit applicant shall be responsible for these forms and/or presentations.

6. Local Roads & Streets Projects - Any projects requiring review by the Bureau of Local Roads & Streets shall require the field engineer overseeing the project, or their designated local agency, to be responsible for the "ADA/PROWAG Inspection" (D1 PD0031) and "ADA Inspection Summary" (D1 PD0039) forms; and if required, the "ADA Maximum Extent Practicable" (BDE 3101) or "ADA Construction Concurrence" (BDE 5801) forms and presentations, as appropriate.

7. Complaints - Any complaints received by the bureaus regarding facilities with non-compliant accessibility and their resolution shall be sent to the District ADA Coordinator for their information. The District's ADA Coordinator or the Bureau of Programming's designated staff will record these complaints in the ADA Inventory Database for future inquiry documentation and/or follow up. Citizen complaints can be received through the IDOT website, email, phone call or in person.

Formal complaints by outside stakeholders shall be submitted in accordance with the ADA Transition Plan. These forms can be found on the IDOT website http://idot.illinois.gov/about-idot/civil-rights/ADA-and-Accessibility/Contacts and emailed to dot.ada.complaints@illinois.gov or mailed to:

    Illinois Department of Transportation
    Bureau of Design & Environment
    Attn: ADA Policy Engineer
    2300 S. Dirksen Parkway, Room 330
    Springfield, IL 62764

All of the mentioned forms can be found on IDOT's SharePoint site under the Forms Section. The District's ADA Coordinators are available to provide more information, assistance or answer inquiries regarding the ADA/PROWAG policy implementation. You may contact the District 1 ADA Coordinators Amrutha Mate, Project Manager, at (847) 705-4330, or Carlos A. Feliciano, In-House Studies Unit Head, at (847) 705-4106 or email DOT.D1.ADA@illinois.gov.
ADA/PROWAG Project Alert

To: Amruta Mate, D1 ADA Coordinator – Programming
Date: ____________________________
From: ____________________________
Location/Bureau: ____________________
Phone/Extension: ____________________
Marked Route/Street Name: ____________________
Limits: ____________________
(attach location map)
Project/Permit No: ____________________
Contract No: ____________________
Section No: ____________________

Type of Work:
☐ Reconstruction ☐ 3R/W&RS ☐ 3P/Resurfacing ☐ Other (explain)

Scope of Work:
__________________________________________

Municipality: ____________________
County: ☐ Cook ☐ Kane ☐ Lake
☐ DuPage ☐ McHenry ☐ Will ☐ Various
Letting ____________________ Design Approval: ____________________

FOR ADA COORDINATOR USE ONLY

NEW FORM FOR THE BUREAUS:
*PROGRAMMING
*DESIGN
*TRAFFIC PERMITS
*LOCAL ROADS

TO ALERT ADA COORDINATOR IN PROGRAMMING OF PLANNED ALTERATION ON STATE ROW
List of facilities altered by construction improvement including curb ramps, crosswalks (marked/unmarked), Traffic Signals (APS), and/or sidewalks. For those facilities that are not compliant, attach ADA/PROWAG Inspection Sheet (D1 PD0031), ADA Construction Concurrency (BDE 5801), and supporting documentation justifying non-compliance. These must be presented by the Bureau in charge of the alteration at the next monthly FHWA/BDE Coordination Meeting. Submit the ADA/PROWAG Inspection Summary form to the D1 ADA Coordinator.

<table>
<thead>
<tr>
<th>Marked Route/Street</th>
<th>Cross Street (for SW, include distance to nearest cross street)</th>
<th>Corner or Leg corner NE/NW/SE/SW Leg N/S/E/W</th>
<th>Crossing Direction (N/S/E/W)</th>
<th>Facility Type</th>
<th>ADA/PROWAG Compliance</th>
<th><strong>FOR NON-COMPLIANT FACILITIES</strong> Inspector must complete the following</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Compliant Non-Compliant</td>
<td>BDE 5801 Completed w/ Documentation Date Presented to FHWA/BDE:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Compliant Non-Compliant</td>
<td>BDE 5801 Completed w/ Documentation Date Presented to FHWA/BDE:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Compliant Non-Compliant</td>
<td>BDE 5801 Completed w/ Documentation Date Presented to FHWA/BDE:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Compliant Non-Compliant</td>
<td>BDE 5801 Completed w/ Documentation Date Presented to FHWA/BDE:</td>
</tr>
</tbody>
</table>

NEW FORM FOR THE BUREAUS OF:

*CONSTRUCTION
*TRAFFIC PERMITS
*LOCAL ROADS

TO CERTIFY ALTERATIONS MADE BY THEM MEET ADA/PROWAG
<table>
<thead>
<tr>
<th>Curb Ramp (CR) Questions (check box for yes)</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Is there a sidewalk leading up to the corner?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Does the CR have detectable warnings? If yes, answer 3, 4, &amp; 5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Are the detectable warnings properly placed?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Are the detectable warnings in good condition?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Do the detectable warnings provide good color contrast?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. If there is concrete or another walking surface adjacent to the sides of the CR, does the ramp have side flares? If yes, answer 7.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Indicate the maximum slope of the side flares (%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. If there is a built-up CR, is it outside of the vehicle path?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9. If there is a marked crosswalk, is the CR contained within it?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10. Are all slope transitions (including gutter) flush and level (½&quot; max or those between ¼&quot; &amp; ½&quot; beveled at a 1:2 slope)?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11. Is there a min. clear space of 4' x 4' at the bottom of the ramp within width of ped street crossing &amp; outside parallel vehicle travel lane?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12. Is a minimum turning space provided at the top of the ramp meeting these requirements? 4' x 4' if unconstrained - 4' x 5' in direction of ramp if constrained. If a space is provided, continue to 13</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13. Is the maximum cross slope of the turning space ≤ 2.00%?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14. Is the minimum width of the CR ≥ 48&quot;? If no, answer 15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15. Record minimum width of CR (inches)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16. Is the maximum cross slope of CR ≤ 2.00%? If no, answer 17</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17. Record maximum cross slope of CR (%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18. Is the maximum CR running slope ≤ 8.3%? If no, answer 19</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19. Record maximum CR running slope (%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20. Is the maximum CR gutter slope ≤ 5.00%?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21. Is the minimum width of adjacent walk ≥ 48&quot;?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Curb Ramp (CR) Questions (check box for yes)</td>
<td>RAMP</td>
<td>RAMP</td>
<td>RAMP</td>
<td>RAMP</td>
<td>RAMP</td>
<td>RAMP</td>
<td>RAMP</td>
<td>RAMP</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td>------</td>
<td></td>
</tr>
<tr>
<td>22  Is the maximum cross slope of adjacent walk ≤ 2.00%?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23  Is the maximum running slope of adjacent walk ≤ 5.00% or ≤ adjacent roadway grade?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>24  Is the surface or any horizontal opening of the CR compliant?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Following questions to be filled out by office personnel:

| 25  Record Illinois State Curb Ramp Condition Rating (1 – 4) |     |     |     |     |     |     |     |     |
| 26  Record Illinois State Curb Ramp User Rating (1 – 4) |     |     |     |     |     |     |     |     |

<table>
<thead>
<tr>
<th>Sidewalk Questions (check box for yes)</th>
<th>SIDE</th>
</tr>
</thead>
<tbody>
<tr>
<td>27  Is there sidewalk along this segment? If yes, answer 28–31</td>
<td></td>
</tr>
<tr>
<td>28  Does sidewalk meet maximum cross slope requirements?</td>
<td></td>
</tr>
<tr>
<td>29  Does sidewalk meet maximum running grade requirements?</td>
<td></td>
</tr>
<tr>
<td>30  Does sidewalk meet minimum width requirements?</td>
<td></td>
</tr>
<tr>
<td>31  Does the surface condition meet requirements?</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Crosswalk Questions (check box for yes)</th>
<th>NORTH LEG</th>
<th>EAST LEG</th>
<th>SOUTH LEG</th>
<th>WEST LEG</th>
<th>OTHER</th>
<th>OTHER</th>
<th>OTHER</th>
<th>OTHER</th>
</tr>
</thead>
<tbody>
<tr>
<td>32  Is the crosswalk marked? If yes, continue to 33</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>33  Record minimum width of crosswalk (inches)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>34  If no yield or stop control, is the cross slope ≤ 5.00% or if yield or stop control, is cross slope ≤ 2.00%? If no for either, continue to 35</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>35  Record maximum cross slope of crosswalk (%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>36  Is the running slope (grade) of the crosswalk ≤ 5.00%? If no, continue to 37</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>37  Record maximum running slope (grade) of crosswalk (%)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>38  Is the surface smooth, firm, stable, slip-resistant?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Traffic Equipment Questions (check box for yes)</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>39  Are there traffic signals?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40  Are there pedestrian signals? If yes, continue to 41–44</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>41  Is there a ped push button within MUTCD recommended area?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>42  Is APS installed?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>43  Do the operable parts allow for 2” dia. use w/closed fist?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>44  Does the ped push button allow for the necessary reach?</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**EXISTING FORM CREATED BY D1 TO INSPECT FACILITIES FOR ADA/PROWAG COMPLIANCE IN STATE ROW**
ADA/PROWAG Field Inspection Instructions

1. Is there a sidewalk leading up to the corner? If no, skip the remaining questions

Detectable Warnings:
2. Are they present? If yes, answer questions 2, 3 and 4.
3. Are they properly placed?
4. Are they in good condition?
5. Do they provide good color contrast?

6. If there is concrete or another walking surface adjacent to the sides of the ramp, does the ramp have side flares?
7. If yes, indicate the maximum slope of the flares. If no, skip this question.

8. If there is a built-up curb ramp, is it outside of the vehicle path?

9. If there is a marked crosswalk, is the curb ramp contained within the marked crosswalk?

10. Are all slope transitions (including back of gutter) flush and level (¼" max or those between ¼" & ½" beveled at a 1:2 slope)?

11. Is there a min. clear space of 4' x 4' at the bottom of the ramp within width of pedestrian street crossing & outside parallel vehicle travel lane?

Existing form created by D1 to inspect facilities for ADA/PROWAG compliance in state ROW
### ADA/PROWAG Field Inspection Instructions

<table>
<thead>
<tr>
<th>Turning Space</th>
<th>Gutter Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>12. Is a minimum turning space provided at the top of the ramp meeting these requirements?</td>
<td></td>
</tr>
<tr>
<td>4' x 4' if unconstrained</td>
<td></td>
</tr>
<tr>
<td>4' x 5' in direction of ramp if constrained</td>
<td></td>
</tr>
<tr>
<td>13. Is the maximum cross slope of the turning space ( \leq 2.00% )?</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Curb Ramp Width</th>
<th>Adjacent Walk Width &amp; Cross Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>14. Is the minimum width of the CR, less side flares/curbs ( \geq 48&quot; )? If no, answer 15</td>
<td></td>
</tr>
<tr>
<td>15. Record the min. width (inches)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Curb Ramp Cross Slope</th>
<th>Adjacent Walk Running Slope</th>
</tr>
</thead>
<tbody>
<tr>
<td>16. Is the maximum cross slope of CR ( \leq 2.00% )? If no, answer 17.</td>
<td></td>
</tr>
<tr>
<td>17. Record the max. cross slope (%)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Running Slope</th>
<th>Horizontal Openings Noncompliant surfaces</th>
</tr>
</thead>
<tbody>
<tr>
<td>18. Is the maximum CR running slope ( \leq 8.3% )? If no, answer 19.</td>
<td></td>
</tr>
<tr>
<td>19. Record max. CR running slope (%)</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>-----------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>20. Is the maximum CR gutter slope ( \leq 5.00% )?</td>
<td></td>
</tr>
<tr>
<td>21. Is the minimum width of adjacent walk ( \geq 48&quot; )?</td>
<td></td>
</tr>
<tr>
<td>22. Is the maximum cross slope of adjacent walk ( \leq 2.00% )?</td>
<td></td>
</tr>
<tr>
<td>23. Is the maximum running slope of adjacent walk ( \leq 5.00% ) or ( \leq ) adjacent roadway grade?</td>
<td></td>
</tr>
</tbody>
</table>

Horizontal openings must not be greater than \( \frac{1}{32} \) in width and must be perpendicular to travel. The example shown here would be noncompliant.
ADA/PROWAG Field Inspection Instructions

41. If there is a pedestrian push button, is it within the area recommended by MUTCD?

44. Does the ped push button allow for the necessary reach?

Note: All reference sections shown are from the Proposed Guidelines for Pedestrian Facilities in the Public Right-of-Way, accessed January 2014.


EXISTING FORM CREATED BY D1 TO INSPECT FACILITIES FOR ADA/PROWAG COMPLIANCE IN STATE ROW
### ADA/PROWAG Field Inspection Instructions

<table>
<thead>
<tr>
<th>Curb Ramp (CR) Questions</th>
<th>Standard</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Is there a sidewalk leading up to the corner?</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Does the CR have detectable warnings? If yes, answer 3, 4, &amp; 5</td>
<td>YES</td>
</tr>
<tr>
<td>3</td>
<td>Are the detectable warnings properly placed?</td>
<td>YES</td>
</tr>
<tr>
<td>4</td>
<td>Are the detectable warnings in good condition?</td>
<td>YES</td>
</tr>
<tr>
<td>5</td>
<td>Do the detectable warnings provide color contrast?</td>
<td>YES</td>
</tr>
<tr>
<td>6</td>
<td>If there is concrete or another walking surface adjacent to the sides of the CR, does the ramp have side flares? If yes, answer 7.</td>
<td>YES</td>
</tr>
<tr>
<td>7</td>
<td>Indicate the maximum slope of the side flares (%)</td>
<td>10%</td>
</tr>
<tr>
<td>8</td>
<td>If there is a built-up CR, is it outside of the vehicle path?</td>
<td>YES</td>
</tr>
<tr>
<td>9</td>
<td>If there is a marked crosswalk, is the CR contained within the marked crosswalk?</td>
<td>YES</td>
</tr>
<tr>
<td>10</td>
<td>Are all slope transitions (including back of gutter) flush and level (¼&quot; max or those between ¼&quot; &amp; ½&quot; beveled at a 1:2 slope)?</td>
<td>YES</td>
</tr>
<tr>
<td>11</td>
<td>Is there a min. clear space of 4' x 4' at the bottom of the ramp within width of pedestrian street crossing &amp; outside parallel vehicle travel lane?</td>
<td>YES</td>
</tr>
<tr>
<td>12</td>
<td>Is a minimum turning space provided at the top of the ramp meeting these requirements? 4' x 4' if unconstrained - 4' x 5' in direction of ramp if constrained. If a space is provided, continue to 13</td>
<td>YES</td>
</tr>
<tr>
<td>13</td>
<td>Is the maximum cross slope of the turning space ≤ 2.00%?</td>
<td>YES</td>
</tr>
<tr>
<td>14</td>
<td>Is the minimum width of the CR ≥ 48&quot;? If no, answer 15</td>
<td>YES</td>
</tr>
<tr>
<td>15</td>
<td>Record minimum width of CR (inches)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Is the maximum cross slope of CR ≤ 2.00%? If no, answer 17</td>
<td>YES</td>
</tr>
<tr>
<td>17</td>
<td>Record maximum cross slope of CR (%)</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Is the maximum CR running slope ≤ 8.3%? If no, answer 19</td>
<td>YES</td>
</tr>
<tr>
<td>19</td>
<td>Record maximum CR running slope (%)</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Is the maximum CR gutter slope ≤ 5.00%?</td>
<td>YES</td>
</tr>
<tr>
<td>21</td>
<td>Is the minimum width of adjacent walk ≥ 48&quot;?</td>
<td>YES</td>
</tr>
<tr>
<td>22</td>
<td>Is the maximum cross slope of adjacent walk ≤ 2.00%?</td>
<td>YES</td>
</tr>
<tr>
<td>23</td>
<td>Is the maximum running slope of adjacent walk ≤ 5.00% or ≤ adjacent roadway grade?</td>
<td>YES</td>
</tr>
<tr>
<td>24</td>
<td>Is the surface or any horizontal opening of the CR compliant?</td>
<td>YES</td>
</tr>
</tbody>
</table>

25. Record Illinois State Curb Ramp Condition Rating. To be completed by staff member assigned to process form.

<table>
<thead>
<tr>
<th>Condition Rating</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Compliant curb ramp</td>
</tr>
<tr>
<td>2</td>
<td>Mostly compliant curb ramp (one or two elements of the curb ramp are in violation)</td>
</tr>
<tr>
<td>3</td>
<td>Mostly non-compliant curb ramp (more than two elements of the curb ramp are in violation)</td>
</tr>
<tr>
<td>4</td>
<td>Missing curb ramp where warranted</td>
</tr>
</tbody>
</table>
ADA/PROWAG Field Inspection Instructions

26 Record Illinois State Curb Ramp User Rating. To be completed by staff member assigned to process form.

<table>
<thead>
<tr>
<th>Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Serving industrial areas, single family residential areas, and other areas not classified as high priority</td>
</tr>
<tr>
<td>2</td>
<td>Serving facilities such as shopping malls, supermarkets, strip retail centers, major employment sites and multi-housing complexes</td>
</tr>
<tr>
<td>3</td>
<td>Serving facilities such as public service facilities, transportation hubs, hospitals, rehabilitation facilities, schools, public housing, parks, and areas with a high concentration of disabled citizens</td>
</tr>
<tr>
<td>4</td>
<td>Serving areas where a specific accessibility request or need has been identified by the disabled community</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sidewalk Questions</th>
<th>Standard</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>27 Is there sidewalk along this segment? If yes, answer 28–31</td>
<td>YES/NO</td>
<td>If yes, , answer 28–31</td>
</tr>
<tr>
<td>28 Does sidewalk meet maximum cross slope requirements?</td>
<td>YES</td>
<td></td>
</tr>
<tr>
<td>29 Does sidewalk meet maximum running grade requirements?</td>
<td>YES</td>
<td></td>
</tr>
<tr>
<td>30 Does sidewalk meet minimum width requirements?</td>
<td>YES</td>
<td></td>
</tr>
<tr>
<td>31 Does the surface condition meet requirements?</td>
<td>YES</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Crosswalk Questions</th>
<th>Standard</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>32 Is the crosswalk marked? If yes, continue to 33</td>
<td>YES/NO</td>
<td>If yes, continue to question 33</td>
</tr>
<tr>
<td>33 Record minimum width of crosswalk (inches)</td>
<td>YES/NO</td>
<td>If yes, continue to question 33</td>
</tr>
<tr>
<td>34 If no yield or stop control, is the cross slope ≤ 5.00% or if yield or stop control, is cross slope ≤ 2.00%? If no for either, continue to 35</td>
<td>YES</td>
<td>If no, continue to question 35</td>
</tr>
<tr>
<td>35 Record maximum cross slope of crosswalk (%)</td>
<td>YES/NO</td>
<td>If yes, continue to question 35</td>
</tr>
<tr>
<td>36 Is the running slope (grade) of the crosswalk ≤ 5.00%? If no, continue to 37</td>
<td>YES</td>
<td>If no, continue to question 37</td>
</tr>
<tr>
<td>37 Record maximum running slope (grade) of crosswalk (%)</td>
<td>YES/NO</td>
<td>If yes, continue to question 37</td>
</tr>
<tr>
<td>38 Is the surface smooth, firm, stable, slip-resistant?</td>
<td>YES</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Traffic Equipment Questions</th>
<th>Standard</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>39 Are there traffic signals?</td>
<td>YES/NO</td>
<td>If yes, continue to question 40</td>
</tr>
<tr>
<td>40 Are there pedestrian signals? If yes, continue to 41–44</td>
<td>YES/NO</td>
<td>If yes, continue to questions 41-44</td>
</tr>
<tr>
<td>41 Is there a ped push button within MUTCD recommended area?</td>
<td>YES</td>
<td></td>
</tr>
<tr>
<td>42 Is APS installed?</td>
<td>YES</td>
<td></td>
</tr>
<tr>
<td>43 Do the operable parts allow for 2” dia. use w/closed fist?</td>
<td>YES</td>
<td></td>
</tr>
<tr>
<td>44 Does the ped push button allow for the necessary reach?</td>
<td>YES</td>
<td></td>
</tr>
</tbody>
</table>

EXISTING FORM CREATED BY D1 TO INSPECT FACILITIES FOR ADA/PROWAG COMPLIANCE IN STATE ROW

Printed 5/4/2015

Instructions

D1 PD0031 (Rev. 12/08/14)
### Route

| Street | Marked | Contract # | State Job # | Section |

| County | Municipality |

| Project Limits |

| Project Length |

| Estimate of Cost |

| Type of Project (e.g. SMART, 3R, Reconstruction) |

| Brief Project Description |

### DOCUMENTATION OF MAXIMUM EXTENT PRACTICABLE (MEP)

| Location(s) Where MEP is Requested |

| Design Element for Which MEP is Requested and Proposed Element Value |

| Design Element Policy Value |

| Coordination Meeting Date |

| Prepared by | Date |

Specify and Explain Reason(s) why Full Compliance is infeasible

- Structural (e.g. bridge beams, buildings, basements, foundations)
- Historic Preservation (e.g. historic buildings, districts, monuments)
- Topography (e.g. steep existing road grade exceeds ADA compliant maximum)
- Utilities (Project scope would not otherwise require utility relocation)
- Right-of-Way (Project scope would not otherwise require R.O.W.)
- Other

Discuss Alternatives Considered (Attach supporting documentation, e.g. plan and profile sheets, photos)

### APPROVAL/DISAPPROVAL

| BDE Approval Date | BDE Disapproval Date |

| BDE Comments on Disapproval |

| DOH Approval Date | DOH Disapproval Date |

| DOH Comments on Disapproval |

| FHWA Approval Date | FHWA Disapproval Date |

**EXISTING FORM BY BDE TO DOCUMENT WAIVER REQUESTS TO FHWA/BDE IN THE PLANNING/DESIGN PHASE**
For pedestrian facilities that cannot be constructed fully compliant and for which there is no approved BDE 3101 ADA Statement of Maximum Extent Practicable, check off area(s) of non-compliance, discuss barriers to compliance and proposed construction to achieve ADA compliance to the maximum extent practicable. Return the form to the district ADA coordinator for concurrence on proposed construction.

<table>
<thead>
<tr>
<th>Job Number</th>
<th>Contract Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Route</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Intersection/Station</th>
<th>Quadrant</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- ☐ Curb ramp running slope
- ☐ Curb ramp width
- ☐ Landing/turning space dimensions
- ☐ Truncated dome orientation
- ☐ Pedestrian push button reach range
- ☐ Curb ramp cross slope
- ☐ Gutter counter slope
- ☐ Landing/turning space cross slope
- ☐ Grade break orientation
- ☐ Other

Discussion of barrier(s) to full ADA compliance and proposed maximum extent practicable design

EXISTING FORM BY BDE TO DOCUMENT WAIVER REQUESTS TO FHWA/BDE AFTER LETTING DURING CONSTRUCTION

<table>
<thead>
<tr>
<th>Resident Engineer/Technician</th>
<th>Date submitted</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>District ADA Coordinator</th>
<th>Date concurred</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
D1 ADA Inventory Efforts

Inventory Efforts

Cost - $2 million in State Engineering Dollars
Miles: 2,973 miles ($670/mile)
Firms - 25 firms (7 under D1 ADA Coordinator)
Contracts - 13 contracts

Schedule:

- November 2013 - BDE Mandates Inventory
- **March 2014 - D1 Submit Partial Altered Inventory**
- September 2014 - D1 Inventory Collection Starts & completed by February 2015
- **March 2015 - D1 Submits Full Inventory**
- May 2015 - Begin QA of Inventory
- April/May 2015 - D1 Staff ADA/PROWAG Training & Initiation of Inventory Updates
D1 ADA Inventory Status

Inventory Status

- **Crosswalks**
  - Total Facilities: 28,494 segments (21,942 were marked)
  - Compliant Facilities: 11,826 (41.5% Compliance)
- **Curb Ramps**
  - Total Facilities: 65,093 ramps
  - Compliant Facilities: 2,257 (3.5% Compliance, 91% in Chicago)
- **Audible Pedestrian Signals (APS)**
  - Total Facilities: 20,793 (73.6% {15,300} w/ Ped Heads/Buttons)
  - Compliant: 100 (0.5% Compliance)
- **Sidewalks**
  - Total Facilities: 48,607 segments (0 State maintained)
  - Compliant: N/A
- **Weigh Stations**
  - Total Facilities: 12
  - Compliant: N/A, TO BE INSPECTED BY CO OPERATIONS
- **Rest Stops**
  - Total Facilities: 1
  - Compliant: N/A, TO BE INSPECTED BY CO OPERATIONS
<table>
<thead>
<tr>
<th>Total Annual ADA Program</th>
<th>Facility Type</th>
<th>Curb Ramps</th>
<th>Crosswalks&lt;sup&gt;1&lt;/sup&gt;</th>
<th>Pedestrian Signals</th>
<th>Sidewalks&lt;sup&gt;2&lt;/sup&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimation only—Based on a 25 year schedule</td>
<td>Number of Facilities</td>
<td>2,458 ramps</td>
<td>294 intersections</td>
<td>57 intersections</td>
<td>4.8 million SF (1,458 segments)</td>
</tr>
</tbody>
</table>

Note: This represents an equivalent number of non-compliant crosswalks are in the same intersection. No agency responsible for bringing sidewalks in the State ROW into compliance has yet been determined.
D1 ADA Inventory Maintenance

Proposed Process

• Step 1 – **Project Alert (new form):** Bureaus will be required to submit a project alert whenever there is an improvement that will potentially alter a State roadway
  *Programming  *Design  *Local Roads  *Traffic Operations

• Step 2 – **Inspection Sheet (D1 PD0031):** Bureaus altering facilities will inspect each facility altered & keep in their records
  *Local Roads  *Traffic Operations  *Construction

• Step 3 – **Inspection Summary (new form):** Bureaus will provide a summary of inspections and compliance to ADA Coordinators. Any non-compliance:
  *Local Roads  *Traffic Operations  *Construction

• Step 3A/B – Fill out **ADA Statement of Maximum Extent Practicable (BDE3101)** before letting or **ADA Construction Concurrence (BDE 5801)** if after letting (i.e. Construction) & present at a monthly BDE/FHWA Coordination Meeting for approval from BDE/FHWA
  *Programming  *Design  *Local Roads  *Traffic Operations  *Construction

• Step 4 – ADA Inventory is updated by the Bureau of Programming noting compliance & report annually to BDE/FHWA.
  *Programming
**D1 ADA Inventory Maintenance**

- **Step 2**
  - Inspection Sheet Form (D1 PD0031) & Guidance
  - Mobile application
  - Web-based

---

**ADA / PROWAG Inspection Sheet**

<table>
<thead>
<tr>
<th>Curb Ramp (CR) Questions (check box for yes)</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
<th>RAMP</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Is there a sidewalk leading up to the corner?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>2. Does the CR have detectable warnings? Yes, answer 3, 4, &amp; 5.</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>3. Are the detectable warnings properly placed?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>4. Are the detectable warnings in good condition?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>5. Do the detectable warnings provide good color contrast?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>6. If there is concrete or another walking surface adjacent to the sides of the CR, does the ramp have side flares? Yes, answer 7.</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>7. Indicate the maximum slope of the side flares (%)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>8. If there is a built-up CR, is it outside of the vehicle path?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>9. If there is a marked crosswalk, is the CR contained within it?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>10. Are all slope transitions (excluding gutter) flush and level (1/2&quot; max or those between 1/2&quot; &amp; 1/4&quot; beveled at a 45°?)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>11. Is there a min. clear space of 4' x 4' at the bottom of the ramp within width of pedestrian crossing &amp; outside parallel vehicle travel lane?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>12. Is a minimum turning space provided at the top of the ramp meeting those requirements? 4' x 4' if unconstrained - 4' x 5' in direction of ramp if constrained, if a space is provided, continue to 13.</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>13. Is the maximum cross slope of the turning space ≤ 2.00%?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>14. Is the minimum width of the CR ≥ 8&quot;? If no, answer 15.</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>15. Record minimum width of CR (inches)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>16. Is the maximum cross slope of CR ≤ 2.00%? If no, answer 17.</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>17. Record maximum cross slope of CR (%)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>18. Is the maximum CR running slope ≤ 8.39%? If no, answer 19.</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>19. Record maximum CR running slope (%)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>20. Is the maximum CR gutter slope ≤ 5.00%?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>21. Is the minimum width of a descent walk ≥ 48&quot;?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>
D1 ADA Inventory Maintenance

- Step 2
  - Inspection Sheet Form (D1 PD0031) & Guidance
  - Mobile/Desktop application

AN OPTION TO EXPEDITE PROCESSING WOULD BE TO HAVE EACH BUREAU UPDATE DATABASE

Collection Format & Instructions
ArcGIS Structure – General Overview
All alterations made to pedestrian facilities will be documented using Inspection Form and an Inspection Summary submitted to Programming to update the ADA Inventory.
Step 3A – Non Compliance during Planning/Design

BDE Form 3101

Bureau submits ADA Statement of Maximum Extent Practicable

Must include:

plan and profile sheets,
elevations, photos, any other relevant documentation along with design alternatives considered

BDE 31-8.04 (c)

&

Presents to BDE/FHWA at a Coordination Meeting for approval
Step 3B – Non Compliance during Construction

BDE Form 5801
Bureau submits to ADA Coordinator the ADA Construction Concurrence
Must include:
plan and profile sheets, elevations, photos, any other relevant documentation along with design alternatives considered
BDE 31-8.04 (c)

Presents to BDE/FHWA at a Coordination Meeting for approval
Programming developing an ADA Training geared to IDOT Engineering Staff:

- Planning to schedule it in the Fall. Currently have over 200 staff members signed up from Traffic, Programming, Local Roads and Construction
- Training would be ideal to inform staff of what their new responsibilities would be
ADA Transition Plan

- The ADA Transition Plan is finalized and available in the IDOT website.
- It was submitted and accepted by the FHWA (26 States have been accepted so far).
- Mandates Districts to address 1/25\textsuperscript{th} of their inventory on a yearly basis

Accomplishments vs. Goals

- OP&P 2016 – Requires PD to track SW, CR, APS, XW for each PPS entry to report in the For The Record yearly document. Will look to Districts to fill in areas where goals are not met.
- BDE – Accomplishment is physically bringing elements to compliance not programming them. Hence the 1/25\textsuperscript{th} Compliance Strategic Goal and the ADA Transition Plan 1/25\textsuperscript{th} Requirement are two different things that shouldn’t be confused.
Designer Notes:
1) All cross slopes are preferred 1.6% (1:64), maximum 2% (1:50).
2) Sidewalk realignment will require detailed design.
3) Areas surrounded by PCC/asphalt, buildings, or are near to driveways, realigned sidewalk, utility and signal poles, or when private sidewalk ties in, will require detailed survey and design.
4) All brick corners will require supervisor approval before using project details.

Construction Notes:
1) All cross slopes are preferred 1.6% (1:64), maximum 2% (1:50) except when transitioning to existing sidewalk.

Legend:
- Existing Grass
- Proposed Side Walk
- Proposed Curb
- Detectable Warnings

State of Illinois
Department of Transportation

Project Detail for Single Perpendicular Curb Ramps
(PD-01)
ADA DETAIL FOR SINGLE PERPENDICULAR CURB RAMPS W/ EXIST. 5% OR GREATER RUN. SLOPE

1) ALL CROSS SLOPES ARE PREFERRED 1.6% (1:64), MAXIMUM 2% (1:50).
2) SIDEWALK REALIGNMENT WILL REQUIRE DETAILED DESIGN.
3) AREAS SURROUNDED BY PCC/ASPHALT, BUILDINGS, OR ARE NEAR TO DRIVEWAYS, REALIGNMENT SIDEWALK, UTILITY AND SIGNAL POLES, OR WHEN PRIVATE SIDEWALK TIES IN, WILL REQUIRE DETAILED SURVEY AND DESIGN.
4) ALL BRICK CORNERS WILL REQUIRE SUPERVISOR APPROVAL BEFORE USING PROJECT DETAILS.

CONSTRUCTION NOTES:
1) ALL CROSS SLOPES ARE PREFERRED 1.6% (1:64), MAXIMUM 2% (1:50) EXCEPT WHEN TRANSITIONING TO EXISTING SIDEWALK.

LEGEN:
- EXIST, GRASS
- PROPOSED SIDEWALK
- PROPOSED CURB
- DETECTABLE WARNINGS

MATCH EXISTING SIDEWALK WIDTH
Design Notes:
1. All cross slopes are preferred 1.6% (1:64), maximum 2% (1:50).
2. Sidewalk realignment will require detailed design.
3. Areas surrounded by PCC/Asphalt, buildings, or near to driveways, realigned sidewalk, utility and signal poles, or when private sidewalk ties in, will require detailed survey and design.
4. All brick corners will require supervisor approval before using project details.

Construction Notes:
1) All cross slopes are preferred 1.6% (1:64), maximum 2% (1:50) except when transitioning to existing sidewalk.

Legend:
- Existing grass
- Match existing sidewalk width
- Existing sidewalk
- Proposed sidewalk
- Detectable warning
- Proposed side curb
- TRANSITION
- Lower landing
- Matching
- Existing
- Proposed
- PCC area
- Landscape
- 2' min.
- 2' max.

State of Illinois
Department of Transportation

Project Design for Double Perpendicular Curb Ramps

PD-03A

PD-03B
DETAILED DESIGN
SURFACE WILL REQUIRE SURFACE. EXIST. CONCRETE MUST BE EXIST. LANDSCAPED 2' MIN.

CURB RAMP TRANSITION

PREFERRED = 7.1% (1:14) MAX. = 8.3% (1:12)

EXIST BUILDING

LANDING

LOWER 15'

EXIST SIDEWALK

FILE NAME S:\WP\PLANPREP\SQUAD_1\Des_RL\Typical ADA details\Typical-ADA-sht-plan.dgn

DETAILED DESIGN
ADDA DETAIL FOR SINGLE PERPENDICULAR CURB RAMPS W/ TURNING SPACE

PD-04A

PD-04B

LEGEND

EXIST, GRASS

PROPOSED SIDEWALK

DETECTABLE WARNINGS

EXIST BUILDING

LANDING

LOWER 15'

EXIST SIDEWALK
1) All cross slopes are preferred 1.6% (1:64), maximum 2% (1:50) except when transitioning to existing sidewalk.
2) Sidewalk realignment will require detailed design.
3) Areas surrounded by PCC/asphalt, buildings, or are near to driveways, realigned sidewalk, utility and signal poles, or when private sidewalk ties in, will require detailed survey and design.
4) All brick corners will require supervisor approval before using project details.

**LEGEND**
- **EXIST**, Grass
- **PROPOSED SIDEWALK**
- **DETECTABLE WARNINGS**

**CONSTRUCTION NOTES:**
1) All cross slopes are preferred 1.6% (1:64), maximum 2% (1:50) except when transitioning to existing sidewalk.

**MATCH EXISTING SIDEWALK WIDTH**
**DESIGNER NOTES:**

1. ALL CROSS SLOPES ARE PREFERRED 1.6% (1:64), MAXIMUM 2% (1:50).
2. SIDEWALK REALIGNMENT WILL REQUIRE DETAILED DESIGN.
3. AREAS SURROUNDED BY PCC/ASPHALT, BUILDINGS, OR ARE NEAR TO DRIVEWAYS, REALIGNED SIDEWALK, UTILITY AND SIGNAL POLES, OR WHEN PRIVATE SIDEWALK TIES IN, WILL REQUIRE DETAILED SURVEY AND DESIGN.
4. ALL BRICK CORNERS WILL REQUIRE SUPERVISOR APPROVAL BEFORE USING PROJECT DETAILS.

**CONSTRUCTION NOTES:**

1. ALL CROSS SLOPES ARE PREFERRED 1.6% (1:64), MAXIMUM 2% (1:50) EXCEPT WHEN TRANSITIONING TO EXISTING SIDEWALK.

**LEGEND:**

- **EXIST, GRASS**
- **PROPOSED SIDEWALK**
- **MATCH EXIST**
- **MATCH EXIST**
- **MATCH EXIST**
- **PROPOSED CURB**
- **DETECTABLE WARNINGS**

**DETAILED DESIGN** SURFACE WILL REQUIRE DETAILED SURFACE. EXISTING CONCRETE MUST BE EXISTED LANDSCAPED.

**PROJECT DETAIL FOR PARALLEL CURB RAMPS**

**STATE OF ILLINOIS**

**DEPARTMENT OF TRANSPORTATION**

**FILE NAME:** S:\WP\PLANPREP\SQUAD_1\Des_RL\Typical ADA details\Typical-ADA-sht-plan.dgn

**USER NAME:**

**PLOT SCALE:**

10.0000 ' / in.

**PLOT DATE:** 11/12/2019

**DATE DESIGNED**

**CHECKED**

**DRAWN**

**REVISED**

**F.A. (PROJECT DETAIL FOR PARALLEL CURB RAMPS)**

**PD-06 (PROJECT DETAIL FOR PARALLEL CURB RAMPS)**

**TOTAL SHEETS**

**SHEET NO.**

**RTE.**

**CONTRACT NO.**

**SCALE:**

**PLANT PREPARATION**

**FILE NAME:**

**USER NAME:**

**PLOT SCALE:**

10.0000 ' / in.

**PLOT DATE:** 11/12/2019

**DATE DESIGNED**

**CHECKED**

**DRAWN**

**REVISED**

**F.A. (PROJECT DETAIL FOR PARALLEL CURB RAMPS)**

**PD-06 (PROJECT DETAIL FOR PARALLEL CURB RAMPS)**

**TOTAL SHEETS**

**SHEET NO.**

**RTE.**

**CONTRACT NO.**

**SCALE:**

**DEPARTMENT OF TRANSPORTATION**

**STATE OF ILLINOIS**
Table of Contents

1. Defining Geometric Design in CADD ................................................................. 4

2. Creating Design Points ...................................................................................... 4
   2.1 Creating a new survey field book in Project Explorer .................................. 4
   2.2 Renaming field book ......................................................................................... 4
   2.3 Modifying point display (Optional) ................................................................. 4
   2.4 Placing design points ....................................................................................... 5
      2.4.1 Inputting design point properties .............................................................. 5
      2.4.2 Placing proposed dummy design point ...................................................... 5
      2.4.3 Placing proposed design points ................................................................. 6
      2.4.4 Modification of proposed design points (as needed) ................................ 6
   2.5 Inputting existing elevations of proposed design points ............................... 6
      2.5.1 Creating elevation labels (existing points only) ......................................... 6
      2.5.2 Inputting existing elevation into design points ......................................... 7

3. Exporting Design Points into ADA Automation Tool ....................................... 7
   3.1 Selecting design points ..................................................................................... 7
   3.2 Generating a point report .................................................................................. 8
   3.3 Exporting report in .xls format ........................................................................ 8
   3.4 Copying report data into ADA Automation Tool spreadsheet .......................... 9

4. Generating Proposed Design Using ADA Automation Tool ............................ 10
   4.1 Renaming template sheet .................................................................................. 10
   4.2 Listing design points in Table 1 ...................................................................... 10
   4.3 Listing design segments in Table 2 .................................................................. 11
   4.4 Defining types of segment in Table 2 .............................................................. 11
   4.5 Overwriting maximum and minimum slope in Table 2 (as needed) ............... 12
   4.6 Defining slope direction in Table 2 (as needed) .............................................. 12
1. Defining Geometric Design in CADD
   Define geometric design in MicroStation utilizing BDE and PROWAG design guidelines and standards.

2. Creating Design Points
   Design points are created for the proposed design at each node using the following steps:

2.1 Creating a new survey field book in Project Explorer

   File -> Project Explorer -> Survey Tab -> right click on Field Books -> New.

2.2 Renaming field book

   Right click on new Field book -> Properties -> enter new name in the name property field.

2.3 Modifying point display (Optional)

   Turn on levels TOPO_POINT SPC CELL and TOPO_POINT NUMBERS.
   Modify point annotation to only display point name by right clicking on All Point Features -> Annotation -> selecting on/off properties to be displayed.
2.4 Placing design points

Open the New Point Feature Toolbox by:
Right click on All Point Features --> New.

2.4.1 Inputting design point properties

Select the newly created field book from drop down menu --> Set the feature definition to 293 --> Create a 5-character name unique to this corner --> Set Control point to False --> Set Terrain Model Attribute to Spot. Continue to next step without exiting any tools, i.e., don’t right-click.

NOTE: It is imperative for the name to be 5-characters in length. No more, no less.

2.4.2 Placing proposed dummy design point

Click through the prompts until a point and elevation appears highlighted in yellow --> click somewhere outside of the sidewalk area to create the dummy point. Continue to next step without exiting any tools.
2.4.3 Placing proposed design points

Continue placing rest of points at nodes of proposed geometric design. Each point, by default, will be assigned a corresponding number following the name and an _.

To simplify later steps, abide by some point-placement convention where, for example, the adjacent points are placed in the direction where the proposed elevation will descend.

2.4.4 Modification of proposed design points (as needed)

Move points by clicking on the point and selecting the center handle. Rename points by going into element information of the point and entering a new name.

2.5 Inputting existing elevations of proposed design points

2.5.1 Creating elevation labels (existing points only)

Use the Label Terrain Spots tool, under the Civil Tools task tab → Terrain Model. Select the existing terrain model when prompted → Click on the existing design point → Click to place label.
2.5.2 Inputting existing elevation into design points

Open element information window for the point → Enter the elevation, placed using the label, into the elevation field.

3. Exporting Design Points into ADA Automation Tool

Data for points created is extracted from CADD and imported into ADA Automation Tool using the following steps:

3.1 Selecting design points

Select all elements in the corner to-be-designed → turn off selection for all elements not in the grey TOPO_POINT SPC CELL level.

NOTE: End-result of selection should only include points created.
3.2 Generating a point report

With points selected use the Point Feature Station Offset Elevation Report tool, found under Civil Tools task tab -> Analysis & Reporting. Follow prompts by selecting any base line that runs through the project -> left-click to create report. A report will open. If a base line, like an alignment, is not available, create one using Line Between Points tool under Civil Tools -> Horizontal Geometry.

3.3 Exporting report in .xls format
Set report format to:
StationOffsetNorthingEastingElevationFeature from the left sidebar. Format of the report needs to match that shown in sub-steps 3.2 and 3.3. It can be modified through Tools -> Format Options. Then, click File -> Save as. Save file in XLS (excel) format somewhere in your project folder.

NOTE: it is recommended to name the exported excel file after the corner name, i.e., 5-character name.

3.4 Copying report data into ADA Automation Tool spreadsheet

Copy the 7-column block from the report Excel Sheet into the first seven columns of the CADD_DATA tab in the ADA_Automation_Tool spreadsheet. Note that all points in the CADD_DATA tab need to be unique. To overwrite a point that is already in the CADD_DATA sheet with a new location, either copy the point row from the MicroStation exported excel into the CADD_DATA tab over the point to be replaced, or simply overwrite all points in the same manner. New points can be added in the same way.
4. Generating Proposed Design Using ADA Automation Tool

Data for proposed design is generated utilizing an algorithm applied in the ADA Automation Tool in the form of a spreadsheet using the following steps:

ADA Automation Tool is a spreadsheet consisting of 3 main tabs: 1. Instruction, 2. CADD_Data, and 3. Corner Name. 3rd tab can be copied over for each ramp/corner to be designed.

4.1 Renaming template sheet

After copying data extracted from CADD to the CADD_DATA tab, first step is to rename the 3rd tab after the corner to be designed using the same 5-character name assigned during Step 2 Creating Design Points.

4.2 Listing design points in Table 1

In Table 1 under column B, list all points of the proposed design using their numbers (or letters if changed in CADD to letters). Proposed points are to be listed in rows 3 to 45, and existing points are to be listed in rows 47 to 71.
4.3 Listing design segments in Table 2

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Type</th>
<th>Max Slope</th>
<th>Min Slope</th>
<th>Max</th>
<th>Min</th>
<th>Slope</th>
<th>Length</th>
<th>Elev. Diff</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>1</td>
<td>Ramp</td>
<td>8.20%</td>
<td>0.00%</td>
<td>8.20</td>
<td>0.00</td>
<td>-6.20</td>
<td>5.46</td>
<td>0.45</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>Lending</td>
<td>1.50%</td>
<td>0.00%</td>
<td>1.50</td>
<td>0.00</td>
<td>-1.00</td>
<td>5.00</td>
<td>0.08</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>Ramp</td>
<td>8.20%</td>
<td>0.00%</td>
<td>8.20</td>
<td>0.00</td>
<td>-6.97</td>
<td>14.50</td>
<td>1.01</td>
</tr>
<tr>
<td>3</td>
<td>4</td>
<td>Lending</td>
<td>1.50%</td>
<td>0.00%</td>
<td>1.50</td>
<td>0.00</td>
<td>-2.00</td>
<td>5.00</td>
<td>0.10</td>
</tr>
<tr>
<td>4</td>
<td>5</td>
<td>Ramp</td>
<td>8.20%</td>
<td>0.00%</td>
<td>8.20</td>
<td>0.00</td>
<td>-4.43</td>
<td>4.45</td>
<td>0.20</td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>Lending</td>
<td>1.50%</td>
<td>0.00%</td>
<td>1.50</td>
<td>0.00</td>
<td>-2.00</td>
<td>4.99</td>
<td>0.10</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
<td>Lending</td>
<td>1.50%</td>
<td>0.00%</td>
<td>1.50</td>
<td>0.00</td>
<td>-1.79</td>
<td>5.92</td>
<td>0.00</td>
</tr>
<tr>
<td>7</td>
<td>8</td>
<td>Ramp</td>
<td>8.20%</td>
<td>0.00%</td>
<td>8.20</td>
<td>0.00</td>
<td>-8.14</td>
<td>5.89</td>
<td>0.48</td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>Lending</td>
<td>1.50%</td>
<td>0.00%</td>
<td>1.50</td>
<td>0.00</td>
<td>-0.74</td>
<td>5.38</td>
<td>0.04</td>
</tr>
</tbody>
</table>

NOTE: In Table 1 and 2 under columns A and E, duplicate entries are pointed out through a red highlight. Points and segments must be unique.

4.4 Defining types of segment in Table 2

Under column J, define the type of each segment. Types will determine the allowable slope range for each segment as defined in the Category table under columns X, Y, and Z.

The maximum and minimum slope under columns N and O are used by the algorithm as constraints to generate the proposed design. These slopes are determined by the type listed under column J, any slope overrides under column K and L, and slope direction if defined under column M.
4.5 Overwriting maximum and minimum slope in Table 2 (as needed)

In Table 2, under columns K and L, overwrite allowable slope range for individual segments as needed.

4.6 Defining slope direction in Table 2 (as needed)

In Table 2, under column M, define slope direction for segments. For example, a segment from 1 to 2 with a slope direction of + indicates that the calculated slope will go up from 1 to 2. Accordingly, a segment from 1 to 2 with a slope direction of - indicates that the calculated slope will go down from 1 to 2. Moreover, if slope direction is left blank, it can go either up or down.
4.7 Running optimization algorithm

Click the CALCULATE button under columns X, Y, and Z to generate the design. An algorithm is applied attempting to generate elevations for the proposed design that are within allowable slope ranges specified by user.

This algorithm is limited to 40 iterations to save time. The OPTIMIZE button will continue the iteration process from the 40th iteration onward.

Slopes calculated using generated proposed elevations will either not be highlighted, highlighted in red, or highlighted in yellow. A red highlight is an indication that the slope is outside slope range specified by user due to rounding error. A yellow highlight is an indication that the slope is outside slope range specified by user due to feasibility or seeding problem. No highlight indicates slope is within range.

NOTE: it’s worth mentioning that the shorter the segment the larger the rounding error.

A message is displayed between the CALCULATE and OPTIMIZE buttons indicative of design status.

4.7.1 Seeding problem

Simply, problem due to seeding can be ruled out by clicking on CALCULATE multiple times, provided after the each run the design violates specified slope ranges.

Every time the CALCULATE button is clicked a random seed, i.e., elevations within the range of existing elevations, is used as a starting point for all elevations in the algorithm. Some random seeds are worse than others leading to the violation of specified slope ranges in some cases. The probability of having a "bad" random seed is about 50% so by running the algorithm multiple times the user can be confident that the violation of slope ranges is NOT due to a bad seed rather, due to feasibility. A random seed for a starting point is also the reason why the user might come across a case where multiple generated proposed designs meeting user specified slope ranges have different proposed elevations. However, if the design meets user specified slope ranges that’s all that matters.
4.8 Extracting data from ADA Automation Tool

4.8.1 Extracting design data in .txt format

Once the proposed design is determined compliant, information is ready to be copied out to a .txt file format as will be explained in the next step (Step 5).

4.8.2 Extracting plan preparation data

Table 3. under columns BA to BD, is an output table for plan-preparation purposes available with proposed design information.

Through a drop-down menu, STATION and OFFSET can be changed to NORTHING and EASTING, as needed.
5. Importing Design Points from ADA Automation Tool into CADD

Data for proposed design is exported from ADA Automation Tool and imported into CADD using the following steps:

5.1 Saving extracted data

As briefly mentioned in sub-step 4.8.1, CADD_DATA tab under column I has proposed design information ready to be imported into CADD after it is copied into a .txt file format.

5.2 Importing extracted data into CADD

Once .txt file is saved, next step is importing the .txt file into CADD. This is done by dragging the .txt file and dropping it in the Project Explorer under Field Books.

If a .txt file already exists for the same corner in the Field Book, delete it before importing the .txt file into CADD.

Once dropped, prompts will ask for format and override options. The format must be IDOT D1-Comma-PtNumNEZCodeCode. Then override all.
5.3 Creating a terrain model

Once data is imported into CADD, next step is to create a terrain from imported data. This is done by clicking on Project Explorer -> right click on Field Books -> Create Terrain Model. The terrain model should show as seen in second image above. If the terrain doesn’t show, check if Terrain EX level and Terrain Ex Exterior are turned on.

If a Terrain Model already exists for the Field Book in Project Explorer under Terrain Models in the Civil Model tab, delete the Terrain Model and recreate it using data imported to the Field Book.

5.3.1 Overwriting imported data

To overwrite the imported data, one must delete the .txt file in Project Explorer under Field Books in the Survey tab. In addition, the terrain must be deleted in Project Explorer under Terrain Models in the Civil Model tab.
5.4 **Modify Design (as needed)**

The design can be modified by adding, removing or relocating design points as needed using the following steps:

1. Modify geometric design
2. Create or move design points as needed to match modified design (Step 2: Creating Design Points)
3. Export points (Step 3: Exporting Points into ADA Automation Tool)
4. Overwrite all points (in CADD_DATA tab of ADA Automation Tool)
5. Update design points and segments (in redesigned corner tab of ADA Automation Tool)
6. In CADD, delete text file and terrain model in Project Explorer (as they will be replaced/recreated)

7. Import points into CADD and recreate the terrain model (Step 5: Importing Points from ADA Automation Tool into CADD)

---

**NOTE:** cross-validate terrain model elevations with spreadsheet elevations to ensure the terrain model has updated with revised elevations.
6. Labeling Design

Labeling data for proposed design is performed in CADD using the following steps:

6.1  Labeling slopes for proposed design

Set active level to Level 47 and use the Analyze Between Points tool to create rough labels for sidewalk slopes.

The Analyze Between Points tool is located under the Civil Tools task tab -> Terrain model. Select the newly created terrain model when prompted. The terrain model is an object referenced in from the 3D model in the same file under the TERRAIN_EX and TERRAIN_EXTERIOR levels. When creating slope labels for crosswalks be sure to select the existing terrain model from the survey file instead. Make sure nothing important is drawn in level 47 (other than slope labels) as it will be modified by a macro in the following step.

6.1.1  Cleaning up labeled slopes

Delete the extra lines and "Slope=" text by running the ADASlope macro from the D1 Blue Menu. The ADASlope macro is found under the Blue Menu -> Macros. This macro deletes all lines and arcs from level 47 and finds and replaces all "Slope=-" and "Slope=" with a blank. This step can be done manually if a macro is not available.

The formatting of the output of this tool is controlled by the active text style and Design file settings. To change the text format, select the standard Place Text tool and select the desired text style. To change the precision, go to Slope Precision option under Settings -> Design file -> Civil Formatting -> Profile Settings Tab.
6.1.2 Adjusting label location

Fine tune the location of the sidewalk slope labels as needed. This can be done by manually moving labels to desired location.

6.2 Labeling elevations for proposed design

Set the active level to an appropriate level other than level 47 and label point elevations using the Label Terrain Spots tool. The formatting of the output of this tool is controlled by the active text style, active dimension style, and the Design file settings. The text and dimension styles are controlled in the same way as the standard Place Note tool through the Label Terrain Spot Toolbox. To change the precision, go to Elevation Precision option under Settings -> Design file -> Civil Formatting -> Profile Settings Tab.
6.3 Labeling dimensions of proposed design

Dimension labeling is done using the standard Dimension Linear tool.

7. Troubleshooting

7.1 Snapping malfunction
Problem: snapping tool not functioning properly when placing newly created points (points not snapping, MicroStation crashing etc.)
Solution: turn off snaps while placing new points, then turn on snaps to modify point location.

7.2 Design point disappearance
Problem: newly created points are disappearing as they’re being created.
Solution: turn off snaps while placing new points.

7.3 Design point information
Problem: point information not updating when imported into CADD.
Solution: in Project Explorer delete .txt file and terrain model. Reimport design data from ADA Automation Tool. Also, sometimes restarting MicroStation might help. As a last resort, delete the points as well as the text file and terrain model in the project explorer before reimporting the points from the text file. Be aware that doing so changes the behavior of the points. For example, now deleting the text file from project explorer will also delete the points.

7.4 Terrain display
Problem: created terrain not displaying.
Solution: use proper Feature Definition for creating points, i.e., 293, and turn on levels Terrain Ex and Terrain Ex Exterior.

7.5 Spreadsheet is slow
Problem: ADA Automation Tool is slow.
Solution: create a new copy of the file.
8. Contact Information

Ahmad Nafakh  
Ahmad.Nafakh@illinois.gov  
Bureau of Design  
IDOT District 1

Radoslaw Rostkowski  
Radoslaw.Rostkowski@illinois.gov  
Bureau of Design  
IDOT District 1
**EXISTING SIDEWALK**

E. 160th STREET

**PROPOSED SIDEWALK**

DETAIL FROM CONTRACT 62J02 FINAL PLANS (JULY 2019 LETTING)

E. 160th STREET

**EXPLANATION OF STEPS**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
</tr>
<tr>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
</tr>
<tr>
<td>604.70</td>
<td>604.83</td>
<td>604.74</td>
<td>604.84</td>
<td>604.74</td>
<td>604.84</td>
</tr>
</tbody>
</table>

**EXISTING SIDEWALK**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
</tr>
<tr>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
</tr>
<tr>
<td>604.70</td>
<td>604.83</td>
<td>604.74</td>
<td>604.84</td>
<td>604.74</td>
<td>604.84</td>
</tr>
</tbody>
</table>

**PROPOSED SIDEWALK**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
</tr>
<tr>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
</tr>
<tr>
<td>604.70</td>
<td>604.83</td>
<td>604.74</td>
<td>604.84</td>
<td>604.74</td>
<td>604.84</td>
</tr>
</tbody>
</table>

**DEPARTMENT OF TRANSPORTATION**

**STATE OF ILLINOIS**

**EXPLANATION OF STEPS**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
</tr>
<tr>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
</tr>
<tr>
<td>604.70</td>
<td>604.83</td>
<td>604.74</td>
<td>604.84</td>
<td>604.74</td>
<td>604.84</td>
</tr>
</tbody>
</table>

**DEPARTMENT OF TRANSPORTATION**

**STATE OF ILLINOIS**

**EXPLANATION OF STEPS**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
</tr>
<tr>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
</tr>
<tr>
<td>604.70</td>
<td>604.83</td>
<td>604.74</td>
<td>604.84</td>
<td>604.74</td>
<td>604.84</td>
</tr>
</tbody>
</table>

**DEPARTMENT OF TRANSPORTATION**

**STATE OF ILLINOIS**

**EXPLANATION OF STEPS**

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
<td>STA</td>
</tr>
<tr>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
<td>604.17</td>
<td>604.31</td>
</tr>
<tr>
<td>604.70</td>
<td>604.83</td>
<td>604.74</td>
<td>604.84</td>
<td>604.74</td>
<td>604.84</td>
</tr>
</tbody>
</table>